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Abstract

Computers provide a powerful tool for the stability analysis of many physical

scenarios. An area where advanced interactive computer analysis software has been

relatively sparse is in the analysis of rock slopes. Interactive software aids in the analysis

of rock slope stability in two main ways: first, by automating long and involved

calculations, thus saving time and minimizing human error and second, by providing

rapid visual feedback on how changing input parameters affects stabihty. In this way, the

rock slope engineer can quickly get a feel for the factors critical to the problem at hand

and the software thus becomes an effective learning tool, in addition to being an analysis

tool.

Three interactive computer programs which aid in the stabihty analysis of rock

slopes have recently been developed at the Institute for Geotechnology, University of

Teimessee, Knoxville rmder a research project funded by the Tennessee Department of

Transportation. These programs are entitled PlaneSlip, WedgeSlip, and RockSlip and are

collectively known as the ROCKSLIP package. PlaneSlip and WedgeSlip implement

limiting equilibrium solutions for plane and wedge slides, respectively, while RockSlip

implements an energy method to analyze the stability of curved or multi-plane failure

surfaces. Application of these programs to the analysis of rock slopes in East Tennessee

and Alabama will be demonstrated with some worked example problems. The worked

examples are also included in a workbook which gives a condensed introduction to the

programs and highlights major features of the programs with each of the example

problems.
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These programs allow the user to interactively adjust the discontinuity geometry,

slope geometry, water pressure, friction angle, cohesion, and slope reinforcement. Water

pressure in PlaneSlip and RockSlip is govemed by the combination of two parameters:

the height of water in a tension crack and a parameter called drainage impedance, which

controls the permeability of the discontinuities. In WedgeSlip there is an input value for

the average water pressure on each plane which can be specified by the user or set to a

default value based on slope geometry. Screen displays of the slope cross section and

stereographic projections of the slope geometry and discontinuity data change in real time

as the user adjusts the variables.
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Part I

Introduction



Introduction

The incorporation of computers into analysis of rock slopes achieves several

useful and effective goals. First, computers can perform thousands of calculations in a

matter of seconds, thus easing the need for tedious hand calculations and reducing the

probability of human error. Second, the ability to observe the effects of changes in input

parameters on slope stability as they are modified makes computer analysis a highly

effective learning tool. The value of "real-time" learning cannot be underestimated. It can

easily illustrate, even to a begiimer, the basic effects that parameters like friction angle

and water pressure have on slope stability.

, Three computer programs have recently been developed at the University of

Tennessee, Knoxville. They are entitled PlaneSlip, WedgeSlip, and RockSlip and are

collectively known as the ROCKSLIP Package. PlaneSlip and WedgeSlip use limiting

equilibrium methods to analyze plane and wedge failures, respectively. RockSlip uses an

energy-based approach developed by Mauldon and Ureta (1996) and Mauldon et. al.

(1998) to analyze failures on curved or multi-planar failure surfaces. Visual Basic 5.0

Professional Edition© has been used to develop the most recent versions of the programs.

The use of this 32-bit developing environment has allowed a compact and eye-pleasing

design for all the programs. Another goal in designing these programs has been the

implementation of "real-time learning" features through the auto-redraw function (found

in PlaneSlip and WedgeSlip). This thesis summarizes the work done on this project and

describes the three computer programs. A User's Guide with step-by-step instructions and

a worked example is included for each program.
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PlaneSlip and WedgeSlip both have "real-time" user interfaces which enables one

to look at how changes in slope geometry and mechanical parameters affect the stability

of a slope. RockSlip lets the user import an image of a slope and then define the failure

surfaces and outcrop parameters to be analyzed.

One of the major objectives undertaken when these programs were being written

was to gain a better understanding of the role of water pressure in failures. "While water

pressure is rather hard to characterize, its effects caimot be ignored or underestimated.

Water pressure depends highly on the permeability of the discontinuities and their

infilling material (if present). Another factor is the drainage conditions at the toe of the

failure surface(s). This factor is controlled in the programs by a parameter entitled

"drainage impedance." Drainage impedance (^) can be seasonally dependent. For

example, it can become greater in the winter when water freezes near the surface outcrop

of a discontinuity and lessen in the summer as the ice melts and allows free drainage.

The original impetus behind this project was the need to implement a new rock

slope stability analysis method for slopes consisting of folded rock geometries. Since the

failure surface in such cases can be regarded as a series of m planes {m > 2), limiting

equilibrium analysis yields an indeterminate answer for these slopes. A method based on

potential energy was developed for stability analysis in folded rocks. This analysis

technique was adapted into the computer program entitled RockSlip. As time progressed,

programs to analyze other basic rock slope geometries were developed. WedgeSlip and
1

PlaneSlip were the results of this effort.



Part II

PlaneSlip

Version 1.3

User's Guide

A computer program for the analysis
of planar rock slope failures.
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Chapter 2.1 Introduction

2.1.1 Program Development

PlaneSlip Version 1.3 was developed by The Institute for Geotechnology,

Department of Civil and Environmental Engineering, The University of Teimessee at

Knoxville as part of a research project for the Tennessee Department of Transportation.

The program authors are Dr. Matthew Mauldon, You Li, Yen-Yit Chan and Joshua Cole.

Any questions or comments about PlaneSlip should be addressed to:

Dr. Matthew Mauldon

Institute for Geotechnology
Department of Civil and Environmental Engineering

The University of Tennessee
Knoxville, TN 37996-2010

- Tel: (423)974-7713 Fax: (423)974-2608
E-mail: mauldon@,utk. edu

Visit the ROCKSLIP web page under Research on the Institute for Geotechnology home

page at:

http://www. engr. utk. edu/research/geo/institute

2.1.2 Disclaimer

The authors disclaim any responsibility for the correctness of the data generated

by the PlaneSlip package, or for the consequences resulting from the use thereof. Any

use or misuse of this package is the sole responsibility of the user.



2.1.3 Program Features

This guide has been developed to help users understand and operate the PlaneSlip

program. PlaneSlip was developed using a simple model of a plane failure situation. The

stability analysis is performed on the basis of limiting equilibrium, following the

discussion of plane slides in the book Rock Slope Engineering (Hoek & Bray, 1981) with

several additional developments. Since plane failure does not involve complex three-

dimensional modeling, it is relatively easy to investigate the sensitivity of a rock slope to

factors such as water pressure or shear strength of the discontinuity. With this fact in

mind, some major features included in PlaneSlip should be brought to the user's

attention.

•  Auto-Redraw - The auto-redraw function enables the user to change key

parameters and see, in "real-time", how these changes affect the slope's stability.

•  Water Level - The height of water in the tension crack controls the magnitude of

water pressure acting on the slope.

•  Drainage Impedance - A parameter entitled "drainage impedance" has been

incorporated into the program! This allows the user to change the pressure

distribution behind the slope by varying the drainage conditions along the sliding

plane and at the toe of the slope.

•  Rockbolts - The effects of rock reinforcement (rock anchors or rockbolts) are also

included in PlaneSlip. Parameters such as number, orientation, tensile and shear

capacity, minimum embedment length and horizontal spacing can be defined for

the rock reinforcement.



•  Tension Crack Angle - The angle of the tension crack can also be adjusted. This

is a feature that has not been included in much of the previous work on rock

slopes (e.g., Hoek & Bray, 1981).

•  Y2K Compliant - PlaneSlip includes no reference to date and is therefore fiilly

Y2K compliant. .

2.1.4 Program Installation

PlaneSlip is compatible with Windows 95/98/NT. Approximately 3MB of free

hard drive space is required to install the program. There are two 3 54" floppy disks

included for the setup of PlaneSlip. Insert the disk labeled "Setup Disk 1 of 2" into the

floppy disk drive (usually labeled drive a: or b:). Click on the Start button, go to Run

and type in "a:\setup.exe" (or "b:\setup" depending on your drive letter). Then simply

follow the instructions that appear on yoiir screen to setup PlaneSlip.

Chapter 2.2 Theory

2.2.1 Geometric Constraints

The following geometric criteria (from Hoek 8c Bray, 1981) are necessary
}

conditions for plane failures:

¤ The plane on which shding occurs must strike parallel or nearly parallel (within

approximately ± 20°) to the slope face.

¤ The failure plane must "daylight" in the slope face. This means that its dip must

be less than the dip of the slope face.

9



¤ The dip of the failure plane must be greater than the angle of friction of this plane

(in the absence of water pressure or other additional loads).

¤ Release' surfaces which provide negligible resistance to sliding must be present in

the rock mass to define the lateral boundaries of the slide. Alternatively, failure

can occur on a failure plane passing through the convex "nose" of a slope.

61

For shding to occur: i|rt > Vp > 6

Figure 2.1 Generalized cross-section of a planar rock
slope showing some geometric requirements
for plane sliding.

Figure 2.1 shows a generalized cross-section of a planar rock slope, where \|ff = dip of

slope face, ijfp = dip of sliding plane, and (J) = friction angle of discontinuity.

Figure 2.2 on the following page shows some of the slope geometries that are possible in

PlaneSlip.

2.2.2 Analysis Assumptions

The following assumptions are made for the analysis of a plane slide. All are

based on Hoek & Bray (1981), except for the assumption concerning water pressure:

►  The sliding surface and the tension crack strike parallel to the slope surface.

10



(a) (b)

(d) (e)

Figure 2.2 Examples of different slope geometries possible in PlaneSlip.
(a) block with a vertical tension crack; (b) block used to model bedding on a dip slope;
(c) block with no tension crack; (d) block with an inclined tension crack and top face;
(e) block with an overhanging face. (When analyzing a slope with an overhanging face,
PlaneSlip does not take into account overturning. It analyzes the block strictly on the basis
of sliding.)

11



►  Water enters the sliding surface along the base of the tension crack and seeps

along the shding surface, escaping at atmospheric pressure where the shding

surface daylights in the slope face. This is the case when there is no drainage

impedance at the toe of the slope. If drainage is impeded then the water pressure

distribution on the sliding surface is modified according to the amount of

impedance. See Figures 2.3a & b for a graphical representation of the two cases.

►  All forces are assumed to act through the centroid of the sliding mass. This

implies that there are no moments created by the forces acting on the block. This

assumption is not the case in most plane slides, but the error introduced by

ignoring the moments is negligible (Hoek & Bray, 1981).

►  The shear strength of the sliding plane is defined by the Mohr-Coulomb criterion:

Tf = c + Of tanij) (2«1)

where Xf = shear stress at failure, c = cohesion, a/ = effective normal stress at

failure, and (j) = fiiction angle.

►  A slice of unit thickness is considered and it is assumed that release surfaces are

present so that there is no resistance to sliding at the lateral boundaries of the

failure.

2.2.3 Water Force

The water, force is calculated in three separate parts depending on the conditions at

the toe of the slope. If the toe is free to drain, the water pressure distribution is that shown

in Figure 2.3a (note that is the depth of water in the tension crack). If drainage at the

12



toe of the slope is completely impeded then the pressure head continues to increase with

depth and the pressure distribution is the same as the free draining case with an additional

triangular pressure block acting perpendicular to the sliding plane (Figure 2.3b). If

drainage at the toe of the slope is partially impeded then the pressure distribution will

vary based on the amount of drainage impedance. An intermediate pressure distribution is

shown in Figure 2.3c. If water reaches atmospheric pressure at a point back into the slope

along the slide plaiie then the water pressure distribution will be like that shown in Figure

2.3d. Negative drainage impedance is used to model this scenario which may occur if the

slide plane has become eroded or opened near the toe of the slope causing water to reach

atmospheric pressure before it reaches the toe of the slope. The amount of negative

drainage impedance is used to determine the point along the slide plane where the

pressure distribution goes to zero. For instance, if the drainage impedance is negative

50%, then the distribution will go to zero at a point halfway along the sliding plane.

W Z,r

H

U

Figure 2.3a Greneralized (Toss-section of a plane
slide with no drainage impedance at the toe of the
slope.
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Figure 23b Generalized cross-section of a plane slide
showing assumed water pressure distribution with
complete drainage impedance at the toe of the slope.

Figure 23c Generalized cross-section of a plane slide
lowing assumed water pressure distribution with
partial drainage impedance at the toe of the slope.

Figure 23d Generalized cross-section of a plane slide
showing assumed water pressure distribution with
negative drainage imped^ce.



2.2.4 Rockbolts

PlaneSlip considers rockbolt reinforcement based on the number, spacing,

capacity and orientation of the bolts, all of which are input by the user. The orientation of

the rockbolts is defined by the angle, 0, that the rockbolts make with the normal to the

face. This angle is easily measured in the field and is also the type of information that

needs to be conveyed to a driller who is installing the rockbolts. Note that this angle can

be positive or negative depending on its orientation with req)ect to the slope face normal.

However, in calculations it is easiw to use the angle, P, the bolts make with the normal to

the failure plane (see Figure 2.4). Note that P can be calculated indirectly firom the dips of

the face and failure plane and the angle, 0. For rockbolts installed in the face (e.g. Fig

2.4), p is given by:

P = Vf-Vp-6 (2.2)

F

Embedment
Length

Figure 2.4 Plane slide schematic defining the
orientation of a rock bolt or cable.
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Another common practice for specifying the orientation of a rockbolt is using the

plunge (i.e. the angle that the downward direction of the bolt makes with horizontal).

When defining the orientation of a line, or in this case the bolt axis, using plunge and

trend it is standard to take the trend as the downward direction of the bolt. To calculate 0

firom a specified rockbolt plunge and trend the following equations (two cases) should be

used (both in degrees):

Case 1: The rockbolt trend is equal to the slope face dip direction.

0 = vj/ j. - 90 - plunge (2.3)

Case 2: The rockbolt trend is equal to the slope face dip direction +180°.

0 = i|/ f - 90 + plunge (2.4)

In PlaneSlip, rockbolts are shown penetrating the slope face first and then the

failure plane (See Figure 2.5). Embedment length is the length of rockbolt that goes

beyond the sliding plane. The user specifies the minimum embedment length (Figs 2.4

and 2.5). If a bolt embedment length is less than the specified minimum, it is drawn as a

dashed line and omitted from the stability calculations. Vertical spacing of the bolts is

calculated by dividing the height of the slope face by the number of bolts. PlaneSlip

automatically assumes uniform vertical spacing of the bolts in the face with the top and

bottom bolts being half the vertical spacing distance from the crest and toe of the slope,

respectively.

16



If rockbolts are to be installed in the top face of the slope, p will be related to 0 by

a different equation.

P=Vt-Vp-6 (2.5)

If a lockbolt does not
meet the minimum
embedment requirement
it is drawn as a dashed
line.

Figure 2.5 Plane slide schematic showing the
number of rockbolts.

All quantities are the same except for ijrt, which is the dip of the top face instead

of the front face. PlaneSlip only shows rockbolts which penetrate the slope face, but

rockbolts in the top face can be modeled accurately as bolts in the slope face by ensuring

that p is the correct value (Figure 2.6). This requires some caution when entering the

value for 0. First calculate p based on the assumption that the rockbolts will be in the top

face (i.e. use equation 2.3). Then insert this value into equation 2.2 to obtain the proper

input value for 0.

17



L  A

(a)

Figure 2.6 (a) Rockbolts in the top face equivalent to
(b) Rockbolts in the slope face.

2.2.5 Limiting Equilibrium

The temi "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. Thus, one must define an index which

describes the relationship between driving and resisting forces for each geometric and

mechanical situation in a rock slope. This is traditionally done using an index called the

Factor of Safety, defined as the ratio of the total resisting force to the total driving force.

For plane sliding with no reinforcement, the equation for calculating the FS is as follows

(Hoek & Bray, 1981). See Table 2.1 for definition of variables.

cA + (Wcosij/p - U - V sin \j/p ) tan <|)
FS =

W sin \[/p + V cos y p
(2.6)

18



The above equation includes the effects of water pressure but does not address the

effects of rock reinforcement. If rockbolts or cables are oriented as shown in Figure 2.3,

then the equation is modified as follows. See Table 2.1 for definition of variables.

cA + (Wcos\(/p -U-Vsinvi/p +NbF]3Cosp)tan(l) + (NbSb /S^)
FS ̂

Wsinv|/p + Vcosv[/p -N^Fb smp

Table 2.1 Definition of Variables

Description

Factor of safety N/A

Cohesion N/A

Area of failure surface N/A

Weight of sliding mass Figure 2.3a-d

Dip of failure plane Figure 2.1

Uplift water force on failure plane Figure 2.3a-d

Water force on tension crack Figure 2.3a-d

Friction angle Figure 2.1

Number of rockbolts with embedment length greater than
the minimum.

N/A

Tensile force in rockbolts Figure 2.4

The angle the bolts make with the normal to failure plane Figure 2.4

Shear strength of rockbolts N/A

Horizontal spacing of rockbolts N/A



Chapter 2.3 Using PlaneSlip

2.3.1 Input Parameters

The following parameters can be input and edited by the user. Most of the

parameters can be found in the variables diagram (Figure 2.7). A brief description, the

units of measurement and range of values are given for each parameter in Table 2.2.

Water Pressure

Figure 2.7 PlaneSlip Variables Diagram



Table 2.2 Definition of Input Parameters fox PlaneSlip.

Par^iitelS Descnption MPnilsfpTp- -
l|K||ib|e|aen|'

^ Ranges^;-;

S'QMiSMim

h Height of slope face. Fig 2.7 Meters or feet 0 to 00

si Length of upper slope. Fig 2.7 Meters or feet

8

os-»
o

al Dip of tension crack. Fig 2.7 Degrees 0 to 180

a2 Dip of sliding plane. Fig 2.7 Degrees 1 to 180

a3 Dip of upper slope. Fig 2.7 Degrees -90 to 90

a4 Dip of slope face. Fig 2.7 Degrees Oto 180

4) Friction angle of sliding
plane.

Fig 2.1 Degrees 0 to 180

c Cohesion of sliding
plane. ,

N/A kPa or psf

8

2
o

Zw Water level in tension

crack.

Fig 2.7 Meters or feet

o

o

Y Unit weight of the rock
mass.

N/A kN/m^ or pcf 0 to oo

Drainage Impedance.
Parameter which

describes the drainage
conditions at the toe of

the slope. 0% = fially
drained toe, 100% = no
drainage at the toe.

Fig 2.3b Percentage - % -90 to

100

Nb Number of rock bolts in

cross-section.

N/A N/A 0 to oo

Lb Length of rockbolts. N/A Meters or feet 0 to oo

0 Angle rockbolts make
with normal to the slope
face.

Fig 2.4 Degrees -90 to 90

Fb Axial force in rockbolts. Fig 2.4 kN or kips 0 to oo

Sb Horizontal spacing of
rockbolts.

N/A Meters or feet 1 to 60

21
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Parameter Description Figure

ME Required embedment Fig 2.4
length.

S|, Shear capacity of N/A
rockbolts.

Units of Range
Measurement

Meters or feet 1 to 30

kN or kips

2.3.2 Display Options

The following options are located in the pull-down menu labeled "Display" at the

top of the screen.

Show Variables Diagram - (on by default) Allows user to choose whether or not to view

the variables diagram. When activated, the variables diagram appears in a fixed position

centered at the top of the picture box.

Enable Auto-Redraw Feature - (on by default) When this feature is enabled, the user can

edit any of the parameters and see the immediate effects that they have on the cross

section and/or factor of safety. Note that if this feature is not enabled then the Update

Screen button must be used to recalculate the factor of safety and redraw the cross-section

for each change in input.

Save as Bitmap... - Allows the user to save the diagram that is currently displayed in the

window as a bitmap. This command calls up a dialog box which allows the user to select

a filename and directory to save the bitmap under.

Note that the user can also capture the currently active form and insert it into a

document. Once the form you want to insert is on the screen and active, press Alt + Print



Screen. This will capture the form. Then go to your document and select Paste to insert

the image where you want it.

2.3.3 Picture Controls

The following controls are located in the lower left hand comer of the picture box.

Zoom In (+) - Allows the user to enlarge the size of the cross-section in the picture box.

Zoom Out (-) - Allows the user to decrease the size of the cross-section in the picture

box.

I,

Clear (C) - Clears the current cross-section out of the picture box. Note that this does not

remove the variables diagram from the picture box. The Show Variables Diagram option,

located under the "Display" pull-down menu, is used to toggle the visibility of the

variables diagram.

Directional Buttons (horizontal and vertical scroll bars) - The directional buttons are

used to move the cross-section aroimd within the picture box.

Reset Button (R) - The reset button returns the cross-section to its original position in the

picture box.

2.3.4 Command Button

Update Screen - The "Update Screen" button is located directly below the picture

box. If the auto-redraw function is not enabled, this button is used to command the

program to redraw the cross-section using the current input and to recalculate the factor

of safety based on the current input.

23



2.3.5 File Options

The following file options are located in the "File" pull-down menu.

Open - Allows the user to open and edit a file containing previously saved data.

Close - Closes the currently opened data file.

Save as - The user can save input data in a text file of their choice. These data files can

then be recalled for use in calculations.

Print - Prints the current program display as seen on the screen.

Exit - Exits the program.

2.3.6 Data

These options can all be found under the "Data" pull-down menu.

Units of Measurement - PlaneSlip allows for the use of two different measuring systems,

^s (English) and SI (Metric). When the units of measurement are changed at run-time,

the program will convert each value to the appropriate unit system.

Typical Mechanical Parameters - PlaneSlip includes some common values for rock unit

weight, discontinuity fiiction angle and rockbolt axial and shear force in the "Data" pull

down menu.

Examples - There are also three example files that can be found imder the "Data" pull

down menu. Example number one is fi:om a limestone quarry, the second from a TRB

special report (Tiuner and Schuster, 1996) and the last jfrom Hoek and Bray's discussion

of plane failures. Clicking on any of these examples automatically inserts the appropriate

data and calculates the factor of safety.

24

/

/



2.3.7 Interpretation of Output

The main form of output in the PlaneSlip iiiterface is the factor of safety display,

located just below the picture box. The picture box also serves as a major source of

output because it presents the cross-section. The variables diagram is optionally displayed

in the picture box.

Factor of Safety - The common output of the program. Displays the calculated factor of

safety for the current input if the auto-redraw function is enabled. If the auto-redraw

function is disabled, displays the factor of safety for the data which was on the screen

when the Update Screen button was last selected.

2.3.8 Worked Example

This example is based on field work done in a limestone quarry in Alabama. The

input data are shown in Figure 2.8. The example presented here corresponds with the

example used in WedgeSlip.

Step 1. Accessing Data - To access the example data (shown in Figure 2.8) go to the pull

down menu labeled "Data". Under that menu there will be a submenu entitled

"Examples". Within that submenu there are several examples listed. Choose Example 1

(Limestone Quarry).

Step 2. Program Appearance - When the example first appears on the screen, the factor

of safety should be equal to one and the maximum water level equal to 4.65 meters. Go to

the "Display" pull-down menu and turn off the variables diagram. A diagram showing a

cross-section of the slope should appear. Figure 2.8 shows how your screen should look

immediately after opening Example 1. You may want to center and enlarge the cross-
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section drawing at this point. Center the diagram using the directional buttons. To

enlarge, simply click on the zoom button located in the lower left comer of the pictme

box. The cross-section should enlarge in regular increments each time the button is

clicked.

Step 3. Slope Geometry - Examine the effects that changing slope geometry have on the

cross-section, and more importantly, on the factor of safety. For example, adjust the value

for the face height, h (initially set to 10 meters), through a range of values and see how

this affects the slope geometry and stability.

[jPjPlaneSlip Version 1.3 Institute for Geotechnology. University of Tennessee. Knoxville
File fiata Disfilay

BiilBG/22/99

FiceHeigiht

Upper Slope LengtJi

Tettsion Crack Axi^

Dip of Slide Plane

Dip of Upper Slope

Dip of Face

FzaciioiiAasle

Cohesion

Water Level

Rock Unit Wei^

Dxainace Iznpedance

Noxnber ofzockbolts

Lenetk of rocl»olis

Factor of Safety =1(1)

Maximum zw = 4.65 m

An^ of rockbolts

Boh Axial Force

Hozaaontal spanng

Mm. Fnibcdznent Update Screen

Boh Shear Force

Figure 2.8 Example 1 output screen as it appears in PlaneSlip.



Step 4. Mechanical Parameters - Now change some of the mechanical parameters of the

slope (i.e. friction angle, cohesion, unit weight). You should find that the slope's stability

is least sensitive to unit weight and most sensitive to changes in the fiiction angle. To

demonstrate this change the fiiction angle from its default value of 30 to 20. The factor of

safety should drop from 1 to 0.63.

Step 5. Water Pressure - Examine the effects of water pressure. As the water level is

increased from zero, the factor of safety should decrease. If one exceeds the maximum

water level, a message saying "Maximum water level exceeded!" should appear. Try

adjusting the drainage impedance. The water pressure distribution (shown on the cross-

section in blue) should change according to the changes made in water level and drainage

impedance. For instance, if the water level increases, an overall increase in the size of the

pressure distribution should be seen. If the drainage impedance is raised, one should note

a marked increase in the pressure distribution near the toe of the slope.

Step 6. Rockbolts - Now add reinforcement to the slope by changing the value for N, the

number of rockbolts. Note any bolts that appear as a dashed line. This means they are not

long enough to meet the minimum embedment requirement and are not included in the

stability calculations. Try varjdng the axial and shear force, orientation and horizontal

spacing of the rockbolts. There are preset values for the rockbolt axial force located in the

"Data" pull-down menu. They are located imder the "Typical rockbolt parameters"

submenu. The values are based on the post-tension stress or 60% of the ultimate strength

of the bolt. As the strength of the bolts is increased, so should the factor of safety. As the

horizontal spacing is increased, the factor of safety should decrease.
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2.3.9 Troubleshooting

The factor of safety display has several comments that are shown imder certain

conditions. The following is a summary of those possible outputs with a brief explanation

of the cause of each output.

Data Entry Wrong - Occurs when the calculated length of the tension crack is less than

zero. Caused by erroneous slope geometry inputs.

Driving Force Acting Against Sliding (factor ofsafety not defined) - Occurs when the

calculated driving force is equal to or less than zero. This creates a problem since the

factor of safety equation will result in a division by zero. This error can be caused by

excessive water force acting on the sliding plane. It can also be a result of erroneous slope
■  /

geometry.
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Chapter 3.1 Introduction

3.1.1 Program Development

WedgeSlip Version 1.3 was developed by The Institute for Geotechnology,

Department of Civil and Environmental Engineering, The University of Tennessee at

Knoxville as part of a research project for the Tennessee Department of Transportation.

The program authors are Dr. Matthew Mauldon, You Li, Yen-Yit Chan and Joshua Cole.

Any questions or comments about WedgeSlip should be addressed to:

Dr. Matthew Mauldon

Institute for Geotechnology
Department of Civil and Environmental Engineering

The University of Tennessee
Knoxville, TN 37996-2010

Tel: (423)974-7713 Fax: (423)974-2608
E-mail: mauldon@,utk.edu

Visit the ROCKSLIP web page under Research on the Institute for Geotechnology home

page at:

http://www.engr.utk.edu/research/geo/institute

3.1.2 Disclaimer

The authors disclaim any responsibility for the correctness of the data generated

by the WedgeSlip package, or for the consequences resulting from the use thereof. Any

use or misuse of this package is the sole responsibility of the user.
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3.1.3 Program Features

The following guide has been developed to help users understand and operate the

WedgeSlip program. WedgeSlip was based on a wedge failure model devised by Hoek &

Bray (1981), with further developments. The mechanics of a wedge failure are analyzed

using limiting equilibrium theory. Since a wedge failure involves the interaction of

several discontinuities and bounding surfaces, it is often difficult to visualize what a

particular slope may look like. WedgeSlip has several features which aid the user in

understanding slope geometry and modeling the slope as accurately as possible.

•  Graphical Output - WedgeSlip incorporates several diagrams (including upper

and lower hemisphere stereographic projections, cross section and variables

diagram) which aid the user in grasping the physical scenario.

•  Auto-Redraw - When used in conjunction with the auto-redraw feature, the

aboVe mentioned diagrams can serve as powerful learning tools. The auto-redraw

feature can also be used to perform sensitivity analyses since it provides real-time

output for each subtle change in geometric or mechanical parameters.

•  Rockbolts - WedgeSlip allows for the addition of rock bolt or cable

reinforcement. Parameters such as number, tensile and shear capacity and

minimum embedment length can be defined for the rock reinforcement.

•  Water Pressure - The effects of water pressure on wedge stability are accounted

for with average water pressure parameters (one value for each plane). For a

detailed explanation of the water pressure calculation see Part 7.
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•  Units of Measurement - WedgeSlip allows for the use of two different measuring

systems, ̂ s (English) and SI (Metric). When the units of measurement are

changed at run-time, the program will convert each value to the appropriate umt

system.

•  Examples - Five example problems are also included under the pull-down menu

"Data", which are based on published results.

•  Y2K Compliant - WedgeSlip includes no reference to date and is therefore fiilly

Y2K compliant.

\

3.1.4 Program Installation

WedgeSlip is compatible with Windows 95/98/NT. Approximately 3MB of free

hard drive space is required to install the program. There are two 3 V2" floppy disks

included for the setup of WedgeSlip. Insert the disk labeled "Setup Disk 1 of 2" into the

floppy disk drive (usually labeled drive a: or b:). Click on the Start button, go to Run

and type in "a:\setup.exe" (or "b:\setup" depending on your drive letter). Then simply

follow the instructions that appear on your screen to setup WedgeSlip.

Chapter 3.2 Theory

3.2.1 Wedge Geometry

The geometry of a wedge, for the purpose of analyzing the basic mechanics of
r

sliding, is defined in Figures 3.1 and 3.2. Some cases involve large, through-going

fractures creating a single wedge which may fail in a violent manner. However, when
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fracture sets are closely spaced in a slope, a series or "family" of small wedges can be

created. In this case, failure is usually a slower, gradual erosion of the slope surface.

Nevertheless, both cases would be modeled using the same general geometry shown in

Figures 3.1 and 3.2. In Figure 3.2, the general requirement is that the slope face dips more

steeply than the line of intersection of the two major discontinuities (i.e., the line of

intersection must "daylight" in the slope face). Likewise, the dip of the line of

intersection must be greater than the rock's friction angle. In symbol form:

(3.1)

where ijfg = dip of the slope face, ij/j = plunge of the line of intersection and (j) = friction

angle.

%
mi '■r.Plane 2

%Plane 1

Figure 3.1 View of wedge geometry
along the line of intersection.

Figure 3.2 View of wedge geometry
perpindicular to the line of intersection.

3.2.2 Analytical Assumptions

The following assumptions are made for the analysis of a wedge slide (due to

Hoek & Bray, 1981):

►  All forces are assumed to act through the centroid of the sliding mass. This

implies that there are no moments created by the forces acting on the hlock. This
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assumption is not the case in most wedge slides, but the error introduced by

ignoring the moments is negligible (Hoek & Bray, 1981).

The shear strength of the sliding planes is defined by the Mohr-Coulomb

criterion:

T = c + a'tan<j) (3.2)

where t = shear stress, c = cohesion, a' = effective normal stress, and (j) =

friction angle.

3.2.3 Water Force

The water force is calculated as the average pressure on each plane times the area

of each plane. The formula used to calculate the average water pressure on each plane is

taken fr:om Hoek & Bray (1981). It is assumed that the distribution on each plane is

tetrahedral. The formula for the average pressure on each plane is as follows:

1
ui = U2 = - X ^  (Yw ̂  ̂ w) (3.3)

Yw-IV2-

HJ2

Assumed Water

Pressure Distribution

Figure 3.3 View perpendicular to the line of intersection showing
the assumed water pressrue distribution. 37



3.2.4 Rockbolts

There is debate over how rockbolts enhance the factor of safety of a rock slope.

One viewpoint is that rockbolts add exclusively to the resisting force. Another possibility

is that the components of the rockbolt force are split between the two, with the normal

component adding to the resisting force and the shear component decreasing the driving

force. Since it is impossible to determine the exact loading and movement sequence in a

rock slope, the choice of which assumption to use becomes arbitrary (Hoek & Bray,

1981). WedgeSlip assumes that the normal component adds to the resisting force and the

shear component decreases the driving force when calculating the factor of safety.

As in PlaneSlip, rockbolts are only drawn in the slope face. But rockbolts

installed in the top face can be modeled (See PlaneSlip User's Guide for method) if care

is taken to get the rockbolt angle, 0, correct. In the case of wedge failure, the plunge of

the line of intersection takes the place of the sliding plane dip in plane failure when

calculating the rockbolt angle.

r-

3.2.5 Limiting Equilibrium

The term "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. Thus, one must define an index which

describes the relationship between driving and resisting forces for each geometric and

mechanical situation in a rock slope. This is traditionally done using an index called the

Factor ofSafety, defined as the ratio of the total resisting force to the total driving force.

For wedge sliding, under gravity, the equation for calculating the Factor of Safety is as

follows. See Table 3.1 for definition of variables.
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I  I

pg _ N] tan(j» + N2 tan(|) + cjAj + C2A2
WSini|/i

(3.4)

If rock bolts are included the factor of safety equation is modified as follows. See Table

3.1 for definition of variables.

FS =
[Nj +Ni +Nb Fb CosP] Tan(|) + NbSb +(ciAi +C2A2)

WSinxj/j -NbFb SinP
(3.5)

Table 3.1 Definition of Variables

i^afei liiMgur^iisQ
N'„N'2 Effective normal forces on planes 1 and 2; Nj' = N; - UjAj N/A

^15 4*2 Friction angle of planes 1 and 2 Figure 3.2

Cj, C2 Cohesive strengths of planes 1 and 2 N/A

A], A2 Area of planes 1 and 2 N/A

W Weight of the' wedge N/A

Plunge of the line of intersection of planes 1 and 2 N/A

U„U2 Average water pressure on planes 1 and 2 Figure 3.3

Nb Number of rockbolts N/A

Fb Tensile force in rockbolts N/A

P Angle rockbolts make with normal to the failure plane N/A

Sb Shear strength of rockbolts N/A
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Chapter 3.3 VsmG WedgeSlip

3.3.1 Input Parameters

The following parameters can be edited by the user. A variables diagram (Figure

3.4) is presented to help visualize wedge geometry. A brief description, the units of

measurement and range of values is given for each parameter in Table 3.2 below.

Plane 1^

Vertical Plane

f  ̂'' ''V
I  » / /

Plane 3

/ /D
.  yC

t J {//

Plane 2

Plane 4

Figure 3.4 WedgeSlip Variables Diagram



Table 3.2 Input parameters for WedgeSlip.

r -

iSlBMiSiif
Measurement

Dip of sliding plane 1. N/A Degrees Oto 180

al Dip direction of sliding
plane 1.

N/A Degrees 0 to 360

ilr2 Dip of sliding plane 2. N/A Degrees Oto 180

a2 Dip direction of sliding
plane 2.

N/A Degrees 0 to 360

ijrS Dip of top face. N/A Degrees -90 to 90

a3 Dip direction of top
face.

N/A Degrees 0 to 360

t|;4 Dip of slope face. Tlffi, Figure
3.2

Degrees Oto 90

a4 Dip direction of slope
face.

N/A Degrees 0 to 360

H Height of slope face. Figme 3.4 Meters or feet 1 to <M

& (1)2 Friction angle on sliding
planes.

Figure 3.2 Degrees 0 to 89

cl & c2 Cohesive strength on
sliding planes.

N/A kPa or psf 0 to oo

ul & u2 Mean pore pressure on
sliding planes.

Figure 3.3 kPa or psf 0 to oo

Y Unit weight of the rock
mass.

N/A kN/m^ or pcf 1 to oo

Nb Number of rock bolts. N/A N/A 0 to oo

U Length of rockbolts. N/A Meters or feet 0 to 00

0 Angle r()ckbolt makes
with normal to the slope
face.

N/A Degrees -90 to 90
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Parameter Description ^ Fipp^■SiSslUnitS'^Ofi. f
Measurement

Range

F. Axial capacity of
rockbolts.

N/A kN or kips

o
o

8

ME Required embedment
length.

N/A Meters or feet 1 to 30

Sb Shear capacity of
rockbolts.

N/A kN or kips 0 to °o

3.3.2 Display Options

The following options are located in the pull-down menu labeled "Upper

Window" and "Lower Window" at the top of the program screen.

Enable Auto-Redraw Feature - This feature is on by default when the program is

initially run. When this feature is enabled, the user can edit any of the parameters and see

the immediate effects that they have on the cross section and/or factor of safety. Note that

if this feature is not enabled then the Redraw and Calculate buttons must be used to

recalculate the factor of safety and redraw the cross-section for each change in input.

Stereograph(UH) or Stereograph(LH) - This displays an upper or lower hemisphere

stereographic projection of the current orientation data. Several options are available for

display:

1. Plot Great Circles - Basic projection of each plane as a great circle on the

stereonet (discontinuities are blue, slope and top faces are red, reference circle is

dashed green).

2. Plot Dip Vectors - Plots the dip vectors for each plane (green).

42



3. Plot Normal Vectors - Plots the normal vectors for each plane (blue).

4. Highlight Removable Wedge (Available for LH projection only) - Highlights the

removable wedge (yellow) as determined by block theory.

Cross Section - Displays a cross section of the current wedge in the corresponding

window. The plane of the cross section is the vertical plane through the line of

intersection of planes 1 & 2 (shaded in Figure 3.4).

Variables Diagram - Displays the variable diagram with plane numbering conventions

and some dimensions of the wedge.

Save as Bitmap... - Allows the user to save the diagram that is currently displayed in

either window as a bitmap. This command calls up a dialog box which allows the user to

select a filename and directory to save the bitmap under.

Note that the user can also capture the currently active form and insert it into a

document. Once the form you want to insert is on the screen and active, press Alt + Print

Screen. This will capture the form. Then go to your document and select Paste to insert

the image where you want it.

3.3.3 Command Buttons

These command buttons are located in the center of the program screen, just

above the two output lines.

Redraw - If the auto-redraw fimction is not enabled, this button is used to command the

program to redraw the cross-section using the current input.

Calculate - If the auto-redraw fimction is not enabled, this button is used to command the

program to recalculate the factor of safety based on the current input.
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3.3.4 Picture Controls

The following controls are located in the lower left-hand comer of each picture

box.

Zoom In (+) - Allows the user to enlarge the size of the cross-section or stereograph in

their respective picture box.

Zoom Out (-) - Allows the user to decrease the size of the cross-section or stereograph in

their respective picture box.

Directional Buttons (horizontal and vertical scrollbars) - The directional buttons are used

to move the cross-section or stereograph around within their respective picture box.

Reset Button (R)- The reset button retums the cross-section or stereograph to its original

position in their respective picture box.

3.3.5 File Options

The following file options are located in the "File" pull-down menu.

Open - Allows the user to open and edit a file containing previously saved data.

Close - Closes the currently opened data file.

Save as - The user can save input data in a text file of their choice. These data files can

then be recalled for use in calculations.

Print - Prints the current program display as seen on the screen.

Exit - Exits the program.
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3.3.6 Data

These options can all be found under the "Data" pull-down menu.

Units of Measurement - WedgeSlip allows for the use of two different measuring

systems, j^s (English) and SI (Metric). When the units of measurement are changed at

run-time, the program will convert each value to the appropriate unit system.

Show Additional Data - This option displays a text box directly below the factor of

safety output line. The box contains useful data that is calculated by WedgeSlip such as

plunge and trend of the line of intersection, area of each plane and volume of the wedge.

Typical Mechanical Parameters - WedgeSlip includes some common values for rock unit

weight, discontinuity friction angle and rockbolt axial force in the "Data" pull-down

menu.

Examples - There are also five example files that can be found under the "Data" pull

down menu. Example number one is from a limestone quarry, the second from a wedge

slide along Interstate 40 in North Carolina, the third is the symmetric case discussed in

Part 7, the fourth from a paper by B.K. Low and the last from TRB Special Report 247.

Clicking on any of these examples automatically inserts the appropriate data and

calculates the factor of safety.

3.3.7 Interpretation of Output

The main form of output in the WedgeSlip interface is the factor of safety and

sliding mode displays, located just below the Calculate and Redraw buttons. The two

pictme boxes also serve as major sources of output because they can present an array of

informative diagrams.
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Factor of Safety - The common output of the program. Displays the calculated factor of

safety for the current input if the auto-redraw function is enabled. If the auto-redraw

function is disabled, displays the factor of safety for the data which was on the screen

when the Calculate button was last selected.

Sliding Mode - Located directly above the factor of safety output line, the sliding mode

output shows whether the sliding mode is double or single plane.

Additional Data - The user may wish to know the plunge and trend of the line of

intersection or the true (dihedral) angle between the planes. This data is calculated by

WedgeSlip and can be displayed by going to the pull-down menu labeled "Data" and

clicking on the "Show Additional Data" command. The data is then displayed in a text

box directly below the program output lines.

3.3.8 Worked Example

The example data is taken from field work done in a limestone quarry in

Alabama. The site contains a multitude of slope configurations. The example presented

here corresponds with the example used in PlaneSlip.

Step 1. Accessing Data - To access the example data (shown in Figure 3.5) go to the pull

down menu labeled "Data". Under that menu there will be a submenu entitled

"Examples". Within that submenu there are several examples listed. Choose Example 1

(Limestone Quarry).

Step 2. Program Appearance - When the example first appears on the screen, the factor

of safety should be equal to one and the sliding mode should be "Single Plane Sliding on

Plane 1". The upper display should contain a cross-section of the wedge. The lower
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display should show a lower hemisphere stereographic projection of the planes in the

slope. Note that the red circles represent the slope and top face, the blue circles represent

the failure planes and the green circle is the reference circle. Figure 3.5 shows how your

screen should look immediately after opening example 1. You may want to enlarge the

cross-section or the stereographic projection at this point. Simply click on the "+" button

located in the lower left comer of each picture box. The cross-section or stereographic

projection should enlarge in regular increments each time the button is clicked.

[^Wedge_Slip Version 1.3 institute for Geotechnologv. Univeisitv of Tennessee, Knoxvliie
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Figure 3.5 Example 1 output screen as it appears in WedgeSlip.
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Step 3. Slope Geometry - Examine the effects that changing slope geometry have on the

cross-section, and more importantly, on the factor of safety. For example, adjust the value

for the face height, h (initially set to 10 meters), through a range of values and see how

this affects the slope geometry and stability.

Step 4. Mechanical Parameters - Now change some of the mechanical parameters of the

slope (i.e. friction angle, cohesion, vmit weight). You should find that the slope's stability

is least sensitive to unit weight and most sensitive to changes in the fiiction angle. Also

note that since there is single plane sliding, only changes in mechanical parameters for

plane 1 will result in a change in the factor of safety. Any change in plane 2 parameters

should have no effect on the factor of safety. For example, decrease the fiiction angle on

plane 1 firom 30 to 20. The factor of safety should decrease fi-om 1 to 0.63. Now decrease

the fiiction angle on plane 2 by the same amount. There should be no change in the factor

of safety.

Step 5. Water Pressure - Examine the effects of water pressure. As the average water

pressure is increased, the factor of safety should decrease. If the water pressure on plane 1

is raised to 40 kPa, a message should inform you that "Normal forces are negative on

planes 1 & 2". This means the slope is highly unstable for this scenario.

Step 6. Rockbolts - Now add reinforcement to the slope. Note any bolts that appear as a

dashed line. This means they are not long enough to meet the minimum embedment

requirement and are not included in the stability calculations. Try varying the axial and

shear force and orientation of the rockbolts. As the strength of the bolts is increased, so

should the factor of safety.
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Step 7. Additional Data - The user may wish to know the plimge and trend of the line of

intersection or the true (dihedral) angle between the planes. This data is calculated by

WedgeSlip and can be displayed by going to the pull-down menu labeled "Data" and

clicking on the "Show Additional Data" command. The data is then displayed in a text

box directly below the program output lines.

3.3.9 Troubleshooting

The factor of safety and sliding mode displays have several comments that are
\

shown when certain conditions exist in the data. The following is a summary of those

possible outputs with a brief explanation of the cause of each output.

Wrong Data Entry - This error message can be caused by a variety of factors. However,

it is usually a result of erroneous wedge geometry which causes a division by zero in the

program calculations. It can also denote that the calculated line of intersection plunges

back into the slope. Make sure that no input values have transposed numbers. If there is

no obvious error, a hand analysis of the wedge in question may be required to determine

the problem.

Driving Force is Upward or Equal to Zero - Occurs when the calculated driving force is

equal to or less than zero. This creates a problem since the factor of safety equation will

result in a division by zero. Usually, this is a result of erroneous slope geometry.

Normal Forces are Negative on Planes 1 & 2- Both planes have normal forces less than

or equal to zero acting on them. This can be caused by infeasible wedge geometries, but

in most cases is a result of excessive water pressure on both planes.
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Sliding Line is Horizontal - The line of intersection is horizontal and does not require

analysis. This is a result of the wedge geometry. Note that water pressure could create an

instability in this situation. However, WedgeSlip assumes that this is an unlikely

occurrence and reports that the sliding line is horizontal.

No Wedge Formed - This error occurs when there is an infeasible wedge geometry

entered. It can mean that the line of intersection plunges back into the slope (among other

things). As mentioned before, if there is no obvious error in the data input then hand

calculations are recommended to decipher the problem.
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Chapter 4.1 Introduction

4.1.1 Program Development

RockSlip Version 1.3 was developed by The Institute for Geotechnology,

Department of Civil Engineering, The University of Tennessee at Knoxville as part of a

research project for the Teimessee Department of Transportation. The program authors

are Dr. Matthew Mauldon, Scott Arwood, You Li, Yen-Yit Chan and Joshua Cole. Any

questions or comments about RockSlip should be addressed to:

Dr. Matthew Mauldon

Institute for Geotechnology
Department of Civil and Environmental Engineering

The University of Tennessee
Knoxville, TN 37996-2010

Tel: (423)974-7713 Fax: (423)974-2608
E-mail: mauldon@utk.edu

Visit the ROCKSLIP web page under Research on the Institute for Geotechnology home

page at:

http://www. engr. utk. edu/research/geo/institute

4.1.2 Disclaimer

The authors disclaim any responsibility for the correctness of the data generated

by the RockSlip package, or for the consequences resulting from the use thereof. Any use

or misuse of this package is the sole responsibility of the user.
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4.1.3 Program Features

The following guide has been developed to help users understand and operate the

RockSlip program. The RockSlip program was developed by modeling a rock wedge with

multiple sliding surfaces as a prismatic block. A new analytical model for determining

slope stability in this situation has been described by Mauldon and Ureta (1996) and

Mauldon, Arwood and Pionke (1998). The model is based on determining the

distribution of normal forces on the failure surfaces by minimizing the potential energy of

the system. The theory will not be presented in detail here. For a detailed discussion

please see Mauldon, Arwood and Pionke (1998). Program features include:

•  Water Level - The height of water in the tension crack controls the magnitude of

water pressure acting on the slope.

•  Drainage Impedance - A parameter entitled "drainage impedance" has been

incorporated into the program, which allows the user to change the pressure

distribution behind the slope by varying the drainage conditions along the sliding

planes and at the toe of the slope.

•  Units of Measurement - RockSlip allows for the use of two different measuring

systems, ̂ s (English) and SI (Metric).

•  Y2K Compliant - RockSlip includes no references to date and is therefore fully

Y2K compliant.

4.1.4 Program Installation

RockSlip is compatible with Windows 95/98/NT. Approximately 4MB of free hard

drive space is required to install the progr^. There should be two 3 Vx" floppy disks

56



included for the setup of RockSlip. Insert the disk labeled "Setup Disk 1 of 2" into your

floppy disk drive (usually labeled drive a: or b:). Click on the Start button, go to Run

and type in "a:\setup.exe" (or "b:\setup" dqjending on your drive letter). Then follow the

instructions that appear on your screen to setup RockSlip.

If you have the "Sample Bitmaps" disk, and wish to access them in RockSlip,

create a new folder entitled "Images" under the directory "C:\Program FilesVRs". This is

the folder that RockSlip will look in when you tell it to open a bitmap. Once you create

the new folder simply copy the files on the "Sample Bitmaps" disk to the new folder.

This will complete the installation process for RockSlip.

Chapter 4.2 Theory

4.2.1 Slope Geometry

Certain geologic environments produce blocks which cannot be modeled accurately as

wedge or plane slides and cannot be evaluated with limiting equilibrium methods. An

example is a block formed by cylindrically folded sedimentary rocks. For this case, the

sediments were initially deposited in horizontal bedding layers. In the millions of years

since, the rocks have been compressed horizontally by tectonic movement. This

compression folded the depositional layers into ridges and valleys. As shown in Figure

4.1, the folds form synclines and anticlines, with synclines being concave upward and the

anticlines concave downward. If the layers are folded and tilted, but not twisted, the

normals to the bedding surfaces will remain coplanar and the folding is termed cylindrical

(Ramsay and Huber, 1987). When these rocks are folded the interlayer contacts are
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weakened, analogous to bending a deck of cards, and interlayer slip may occur. When

slopes are cut through these folded rocks, failures may occur along the contacts of these

bedding layers. The sliding surface in such cases cannot be described as single plane or

an intersection of two planes, but is a curved surface as in Figure 4.2. Studies have shown

that if these blocks are idealized as a two plane wedge, as is commonly done in practice,

the factor of safety may be overestimated (Mauldon, Arwood and Pionke, 1998). A

cylindrical block could be idealized as a prismatic block with multiple sliding planes, all

with parallel lines of intersection, as shown Figure 4.3. The model for the stability of

these prismatic blocks will be presented first and then extended to where the number of

planes m approaches infinity. A local coordinate system, which will later be used in the

model development, is also defined in Figures 4.2 and 4.3 with the Z axis parallel to the

fold axis and Xand Fin the plane orthogonal to the fold axis.

wr
'A

%

Ar,

(b)(a

Figure 4.1 Two fold structures (a) a syncline, and (b) an anticline (Wilson, 1981).
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fold axis

upper slope

slope face

Figure 4.2 Cylindrical block formed in folded
rocks.

upper slope

slope face

fold axis

Figure 4.3 Cylindrical block idealized as a
prismatic block.
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4.2.2 Analytical Assumptions

The following assumptions are made when the potential energy model is

implemented in RockSlip:

*■ Each contact face of the rock block, n, is assumed to have a normal stiffiiess of k„,

whereas the previously published work employed a uniform spring stiffiiess

constant for all contact surfaces.

The block itself is assumed to be undeformable, deformation occurring only at the

contact faces.

►  The block is acted upon by an active resultant force R, which includes self weight,

and may include other forces such as water pressure and cohesion.

►  An important assumption is that the fiictional shear stresses act parallel to the

direction of sliding only (Hoek and Bray, 1981; Chan and Einstein, 1981). This is

a standard assumption in limiting equilibriiun analyses.

►  An elastic, conservative system is assumed to determine the distribution of normal

forces that minimizes the potential energy of the system. Knowledge of these

normal forces will then allow the stability to be determined.

►  The coordinate system is the same as that defined in Figure 4.3.

►  Each plane has a length Z„ in the XY plane, and since this is a prismatic block, the

other dimension of the contact plane will be taken as a unit length in the Z (fold

axis) direction.
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4.2.3 Water Force

A detailed explanation of the water force calculation can be found in Part 8 of this

document. The same basic principles used in WedgeSlip are utilized in the RockSlip

calculations. The major difference is that the volume calculation in RockSlip is much

more complicated and is obtained by Gaussian Numerical Integration. The parameter z,

height of water level in tension crack, and drainage impedance are included in the

"Outcrop" form and can be modified according to the water level and drainage conditions

of the slope.

4.2.4 Potential Energy Minimization

RockSlip deals with failures involving multiple or curved sliding surfaces. The

analysis procedure, which was originally developed for stability analysis in folded rocks,

is based on minimization of potential energy. For a detailed explanation of the potential

energy minimization method please refer to Mauldon and Ureta (1996) and Mauldon,

Arwood and Pionke (1998). Due to the lengthy mathematical formulations involved, an

explanation of the method will not be presented here.

I  Chapter 4.3 Vsmo RockSlip

4.3.1 Saving Bitmaps

The first step to operating RockSlip is to open a bitmap or points file. It is

important that the user, store his/her bitmaps under a directory that can easily be found

{RockSlip defaults to the directory "C:/Program Files/Rs/Images" when opening a
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bitmap). The size at which bitmaps are saved determines whether the user will be able to

view the slope picture in its entirety. For the entire bitmap image to fit into the "Profile"

form it needs to be 360 x 235 pixels. The easiest way to accomplish this task is to resize

the image with an image editor (L View, Adobe Photoshop, Corel Photo House). Be

careful to preserve the aspect ratio when resizing the bitmap, otherwise, your image may

be distorted which may affect the computed factor of safety. Once the size of the bitmap

is correct, one can open it and begin to define the failure planes to be analyzed.

4.3.2 Defining Planes

The following method will focus on using a bitmap to define the sliding planes.

To open a bitmap, click on the File pull-down menu. There should be two submenus

entitled "Open Bitmap" and "Open Points". Clicking on the "Open Bitmap" submenu

causes an "Open File" dialog box to be displayed. The user can browse through the

directories and find the appropriate bitmap. After the bitmap is open and showing in the

"Profile" form, the user can move the mouse around to define the coordinates of the

planes. Click once on the picture to define the beginning of a line and move the mouse to

the desired endpoint and click again. Make sure that the plane coordinates are defined

from right to left. In this manner, all the sliding planes can be defined in terms of

coordinates on the Visual Basic axes. The next step is to enter in the input parameters

from the outcrop data. To accomplish this, click on the Next button to bring up the

"Outcrop" form.
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Figure 4.4 RockSlip Variables Diagram

4.3.3 Input Parameters

Input parameters, which are displayed next in the "Outcrop" form, can be edited

by the user. A brief description, the units of measurement and range of values is given for

each parameter in Table 4.1.

4.3.4 Picture Controls

Once the outcrop information has been entered, click on the Next button and the

"Calculate" form will appear. There are two diagrams displayed along with the Factor of

Safety and other results on this form. One is the apparent section. The apparent section

is how the defined planes appear as they are drawn on the bitmap. The true section
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corrects the previous picture based on the orientation of the fold axis, with respect to the

outcrop face orientation. The user also has four zoom options (25%, 50%, 100% and

200%) located to the right of the two diagrams.

Table 4.1 Definition of Input Parameters for RockSlip.

Parameter

■salislia

.  Description Units of
Stiasuremfent

Range

Fold Axis
Trend

Trend of fold axis. Fig 4.2 & 4.3 Degrees 0 to 360

Fold Axis
Plunge

Plunge of fold axis. Fig 4.2 & 4.3 Degrees 0 to 90

Outcrop
Dip

Dip of outcrop face. N/A Degrees 0 to 90

Outcrop
Dip

Direction

Dip direction of outcrop
face.

N/A Degrees 0 to 360

Friction
Angle

Friction angle of sliding
planes.

N/A Degrees 0 to oo

Water Level Water level (vertical
height) in tension crack.

z. Fig 4.4 Meters or feet 0 to oo

Drainage
Impedance

Parameter which
describes drainage
conditions at the toe of
the slope. 0% = fully
drained toe, 100% = no
drainage at toe.

N/A %

!

1

Oto 100

1
1

Upper Slope
Length

Length of upper slope. L, Fig 4.4 Meters or feet 0 to oo

Cohesion Cohesion of sliding
planes.

N/A kPa or psf 0 to oo

Unit Weight Unit weight of the rock
mass.

N/A kN/m^ or pcf 0 to oo
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4.3.5 Interpretation of Output

The main form of output in the RockSlip interface is the "calculate" form. The

output box located on this form displays several paragraphs of output including the factor

of safety, outcrop data, number and length of planes and other data. The two picture

boxes also serve as sources of output because they show how the wedge looks in apparent

and true cross-section. Clicking on the "Finish" button exits the analysis.

4.3.6 Worked Example

The following example is based on data gathered from a field site in Biltmore, TN

(Arwood, 1996). The outcrop information is already entered in the program as the default

settings. Depending on the number of planes defined, a variety of different factors of

safety are obtained.

Step 1. Accessing Bitmaps - To access the example bitmap, go to the pull-down menu

"File" and select "Open Bitmap". A dialogue box should open to the directory where the

sample bitmaps (included with program) are located. Choose "BiltlA.bmp" and press

open. (See Figure 4.5).

Step 2. Defining Failure Planes - Once the Biltmore bitmap has been chosen, one can

now define the failure planes to be analyzed. Begin by examining a wedge configuration

(See Figure 4.6)^ i.e. define two planes. After the two planes have been defined, click the

next button.
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Figure 4.5 Opening a Bitmap m RockSlip
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Figure 4.6 Defining Planes (Wedge Configuration)



' RockSlip Veision1.3 Institute for Geotechnology, University of Tennessee, Knoxville ...
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different rocks. Lower value is generally given by
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Figure 4.7 "Outcrop" form with default data.

Step 3. Program Appearance - The "Outcrop" form should appear as in Figure 4.7, with

the same default data. This data corresponds to the field data gathered from the Biltmore

site. Click on the next button.

Step 4. Results - RockSlip now displays the "Calculate" form. All the outcrop information

is summarized in this form (See Figure 4.8). The factor of safety is also reported. The

factor of safety should be in the range of 2.3 to 2.5 depending on how you defined your

planes.

Step 5. Outcrop Data - Click the back button to go to the "Outcrop" form. At this point,

one can adjust the outcrop data (i.e. fold axis and outcrop orientation, mechanical
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«Back Finish»

Figure 4.8 "Calculate" form as it appears in RockSlip

parameters, etc.) and see how it affects the factor of safety. For instance, if you decrease

the friction angle from 20 to 10 and click the next button the factor of safety should drop

considerably (for a trial run, the FS dropped from 2.48 to 1.19 when the friction angle

was lowered from 20 to 10). Try changing all of the parameters and observe the effects

they have on the factor of safety. One important thing to notice is how RockSlip handles

the true" versus "apparent" section diagrams. Try adjusting the dip direction of the slope

face or the fold axis trend to values which are significantly different. Then click next. The

apparent section should be quite different from the true section. As the two values get

closer to each other, however, the true and apparent sections should come closer to

agreeing with one another.
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Figure 4.9 Three sided failure surface in RockSlip.

Step 6. 3-sided and 5-sided Failure Surfaces - Now examine two more plane

configurations, the 3-sided and 5-sided failure surfaces. Click the back button until you

arrive at the "Profile" form. Click the clear all button to erase the previous plane

definitions. Now define 3 planes along the failure surface (See Figure 4.9) and repeat

steps 3 through 5. The factor of safety should be in the range of 1.3 to 1.5. Repeat the

process and define 5 planes for the next analysis (See Figure 4.10). The factor of safety in

this case should be between 1.0 and 1.4.
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Figure 4.10 Five sided failure surface in RockSlip.

4.3.7 Troubleshooting

If there is an error in the calculations a message box will appear before the results

form appears. The following is a summary of the possible outputs that can appear in the

message box.

Driving Force is Upward or 0! - The driving force acting on the block is less than or

equal to zero. This means that for the particular geometry and input values the block is

stable.

Normal Force is Negative - The normal force acting on each plane is less than or equal to

zero. This causes the frictional resistance on each plane to be zero also. This denotes a

highly unstable block. This problem is likely caused by excessive water force acting on

the sliding planes.
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Verification and Examples

This chapter presents some simple examples which can be checked analytically.

Comparisons between the results from the computer program and the analytical results

are presented in Tables 5.1, 5.2 and 5.4. Also presented are comparisons with published

results (Table 5.3).

5.1 PlaneSlip

5.1.1 Plane Example (No Tension Crack)

X

Figure 5.1 Plane example (no tension crack)

This example uses a simple slope geometry (Figure 5.1) to verify PlaneSlip. The point a

is fixed at the midpoint of the side of the cube. The angle a is variable in the range

(26.57°, 90°), thus a variety of plane geometries are possible depending on its value. A



unit length of 1 in the perpendicular direction is assumed. To calculate the Factor of

Safety against plane sliding, the following steps are taken:

Step 1. Calculate the volume of the prism of rock

Volume = Vi x base x height x length of prism = 5/2 x 1 x cot a = cot a / 2

Step 2. Calculate the weight of the prism

Weight = W = Volume x Unit Weight = cot a x y / 2

Step 3. Calculate the driving force

Fp = W sin a - NT sin P

Step 4. Calculate the resistingforce (without water pressure)

Fr = (W cos a + NT cos P) x tan (]) + (c / sin a) + NS

where N = number of rockbolts embedded a length greater than the minimum embedment

length, T = tensile force in rockbolts', p = the angle the bolt or cable makes with the

normal to the failure plane, c = cohesion, (J) = friction angle, S = shear force (dowel

effect) produced by a single rockbolt and 1 / sin a is the length of the slide plane for the

no tension crack case.

Step 5. Calculate the factor ofsafety

FS = Fr / Fd = [(W cos a + NT cos p) x tan (j) + (c / sin a) + NS] / W sin a - NT sin p

5.1.2 Plane Example (With Tension Crack)

Now add a tension crack (fixed as a vertical plane through the middle of the cube)

and introduce water pressure. This sets the face height and the length equal to 1 (Figure

5.2). Note that the length of the sliding plane is calculated differently than the no tension

crack case. Water pressure decreases the resisting forces and increases the driving forces.
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Figure 5.2 Plane example (with tension crack)

Figure 5.2 is a diagram illustrating the assumed pressure distributions for this model. If

there is drainage impedance at the toe of the slope then the distribution will be modified

accordingly (denoted by the dotted line). Rockbolts and cohesion are omitted from these

calculations.

Step 1. Calculate the volume of the prism of rock

Volume = (1 X 1 - 54 (tana x i)) x l = l - tan a / 2

Step 2. Calculate the weight of rock

Weight = (1 - tan a / 2) X Y

Step 3. Calculate the waterforce, V, on the tension crack (fully drained toe)

V = 54 X X z2

Step 4. Calculate the waterforce, , on the sliding plane

Ud = 54 X y^ X z (1 / cos a)

Step 5. Calculate the effective stress, N', acting on the slide plane

N' = W cos a - V sin a - Un

Step 6. Calculate the factor ofsafety for a fully drained toe



FS = N' tan (J) / (W sin a + V cos a)

Step 7a. Calculate the added water force, U', on the sliding plane when drainage at the

toe is completely impeded

U' = V2 (tan a + z)Yw(1 / cos a)

Thus, the total water force, Uy, on the sliding plane for a fully impeded toe (undrained

case) is:

Uu = Ud + U'

Step 7b. If the toe is not fully impeded, then the added waterforce, U', is modified by the

amount of drainage impedance, f. The equation becomes:

U, = U„ + gxU')

Step 7c. If there is negative drainage impedance, then is calculated with a different

equation:

Uj) = ̂/2 X Yw ̂  z X [(1 + 0 X (1 / cos a)]

In either case, the correct value for U should be substituted into the factor of safety

equation to obtain the correct factor of safety.

5.1.3 Verification

These examples were entered in PlaneSlip and the factor of safety acquired for

each case. These results were compared with spreadsheet calculations based on the

previous formulas. Four examples for each variable were run, with all other variables

being held constant, and results obtained. The following spreadsheet (Table 5.1) shows

the results from both cases (with and without tension crack) and compares them with

results from PlaneSlip, thus verifying the accuracy of PlaneSlip for these simple cases.
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Table 5.1 PlaneSlip verification exercise (see Table 2.2 for definition of variables).
PlaneSlipVenficztion Exercise

6/24/99

a T
c N T s B 1 z Vol Wt. V Ud U' Fr Fd FS FS(PS)

20 25 30 0 0 1 1 10 0 0 1.4 34.3 0.00 0.00 0.00 18.6 11.7 1.59 1.59

40 25 30 0 0 1 1 10 0 0 0.6 14.9 0.00 0.00 0.00 6.6 9.6 0.69 0.69

60 25 30 0 0 1 1 10 0 0 0.3 7.2 0.00 0.00 0.00 2.1 6.3 0.33 0.33

80 25 30 0 0 1 1 10 0 0 0.1 2.2 0.00 0.00 0.00 0.2 2.2 0.10 0.10

30 26 30 0 0 1 1 10 0 0 0.9 22.5 0.00 0.00 0.00 11.3 11.3 1.00 1.00

30 27 30 0 0 1 1 10 0 0 0.9 23.4 0.00 0.00 0.00 11.7 11.7 1.00 1.00

30 28 30 0 0 1 1 10 0 0 0.9 24.2 0.00 0.00 0.00 12.1 12.1 1.00 1.00

30 29 30 0 0 1 1 10 0 0 0.9 25.1 0.00 0.00 0.00 12.6 12.6 1.00 1.00

30 25 10 0 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 3.3 10.8 0.31 0.31

30 25 20 0 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 6.8 10.8 0.63 0.63

30 25 30 0 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 10.8 10.8 1.00 1.00

30 25 40 0 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 15.7 10.8 1.45 1.45

30 25 30 5 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 20.8 10.8 1.92 1.92

30 25 30 10 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 30.8 10.8 2.85 2.85

30 25 30 15 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 40.8 10.8 3.77 3.77

30 25 30 20 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 50.8 10.8 4.70 4.69

30 25 30 0 2 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 14.0 10.5 1.33 1.33

30 25 30 0 4 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 17.1 10.1 1.69 1.69

30 25 30 0 6 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 20.2 9.8 2.07 2.07

30 25 30 0 8 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 23.4 9.4 2.48 2.48

30 25 30 0 1 5 1 10 0 0 0.9 21.7 0.00 0.00 0.00 14.7 10.0 1.47 1.47

30 25 30 0 1 10 1 10 0 0 0.9 21.7 0.00 0.00 0.00 17.5 9.1 1.93 1.93

30 25 30 0 1. IS 1 10 0 0 0.9 21.7 0.00 0.00 0.00 20.4 8.2 2.48 2.48

30 25 30 0 1 20 1 10 0 0 0.9 21.7 0.00 0.00 0.00 23.2 7.4 3.16 3.16

30 25 30 0 1 1 10 0 0 0.9 21.7 0.00 0.00 0.00 16.4 10.7 1.54 1.54

30 25 30 0 1 1 10 10 0 0 0.9 21.7 0.00 0.00 0.00 21.4 10.7 2.01 2.01

30 25 30 0 1 1 15 10 0 0 0.9 21.7 0.00 0.00 0.00 26.4 10.7 2.48 2.48

30 25 30 0 1 1 20 10 0 0 0.9 21.7 0.00 0.00 0.00 31.4 10.7 2.95 2.95

30 25 30 0 1 1 1 20 0 0 0.9 21.7 0.00 0.00 0.00 12.4 10.5 1.18 1.18

30 25 30 0 1 1 1 40 0 0 0.9 21.7 0.00 0.00 0.00 12.3 10.2 1.20 1.20

30 25 30 0 1 1 1 60 0 0 0.9 21.7 0.00 0.00 0.00 12.1 10.0 1.22 1.22

30 25 30 0 1 1 1 80 0 0 0.9 21.7 0.00 0.00 0.00 11.9 9.8 1.21 1.21

30 25 30 0 0 0 0 0 0.1 0 0.7 17.8 0.05 0.57 0.00 8.6 8.9 0.96 0.96

30 25 30 0 0 0 0 0 0.2 0 0.7 17.8 0.20 1.13 0.00 8.2 9.1 0.90 0.90

30 25 30 0 0 0 0 0 0.3 0 0.7 17.8 0.44 1.70 0.00 7.8 9.3 0.84 0.84

30 25 30 0 0 0 0 0 0.4 0 0.7 17.8 0.78 2.27 0.00 7.4 9.6 0.77 0.77

30 25 30 0 0 0 0 0 0.1 -50 0.7 17.8 0.05 0.28 0.00 8.7 8.9 0.98 0.98

30 25 30 0 0 0 0 0 0.1 -25 0.7 17.8 0.05 0.42 0.00 8.6 8.9 0.97 0.97

30 25 30 0 0 0 0 0 0.1 0 0.7 17.8 0.05 0.57 0.00 8.6 8.9 ii#96r 0.96

30 25 30 0 0 0 0 0 0.1 0 0.7 17.8 0.05 0.57 0.00 8.6 8.9 0.96 0.96

30 25 30 0 0 0 0 0 0.1 25 0.7 17.8 0.05 0.57 0.96 8.0 8.9 0.90 0.90

30 25 30 0 0 0 0 0 0.1 50 0.7 17.8 0.05 0.57 1.92 7.4 8.9 0.83 0.83

30 25 30 0 0 0 0 0 0.1 75 0.7 17.8 0.05 0.57 2.88 6.9 8.9 0.77 0.77

30 25 30 0 0 0 0 0 0.1 100 0.7 17.8 0.05 0.57 3.84 6.3 8.9 0.71 0.71

a Y c N T s p z 5 Vol Wt. V Ud U' Fr Fd FS FS(P5)

Note: Shaded cell represents factor of safety calculated using negative drainage impedance algorithm. Used as a check
for the value of 0 against the positive drainage impedance algorithm.
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5.2 WedgeSlip

5.2.1 Wedge Example (No Tension Crack)

The following example is a case designed to utilize symmetry for ease of

calculation. The wedge that is to be analyzed can be visualized as a portion of a cube. For

this example, the sides of the cube are set at an arbitrary length of 2. Figme 5.3 is a

schematic diagram showing the wedge geometry for this example.

ProiileView
DD2 T DDI

Top View

Figure 5.3 Wedge slide schematic.

Step 1. Calculate the Volume of the Wedge

The wedge can be visualized as a pyramid with variable base, h, and height of 1.

The formula for the volume of a pyramid is as follows:

Volume = V3 * base * height =V3*h*l=h/3

Step 2. Calculate the Weight of the Wedge

The weight of the wedge is simply its volume times the unit weight of the rock



Weight of the wedge = Voliune * Unit Weight (y) = Y * ̂ / 3

Step 3. Dip and Dip Direction of Planes

North is defined as the dip direction of the slope face. The first step is to find the

relationship between the true dip, 6, and apparent dip, 6', of the two planes. The

following diagram (Figure 5.4) illustrates a section of the cube. All quantities are labeled

on the diagram. Thus, trigonometric relationships between the angles can be found. From

the diagram, the following trigonometric relationships can be derived:

Tan 6 = h/w

Tan 6' = h/w'

Cos p=w/w'=»w = w' Cos P

.-. Tan6 = h/ w = h/(w'* Cos P) = Tan6' /Cos P

For this example, 6' = Tan"' h; P = 45 °. Therefore, 6 = Tan"' (h / Cos 45) = Tan"' if 2 * h).

Thus, we have the following dip and dip direction equations for the two planes:

Dip 1 = Tan"' * h); Dip Direction 1 = 45 Dip 2 = Tan"' (fl * h);

Dip Direction 2 = 315 °.

Figure 5.4 Diagram illustrating the
relationship between apparent and true dip.



Step 4. Determine the Plunge of the Line ofIntersection

By inspection, the plunge of the line of intersection, t|;, is equal to Tan"' h.

Step 5. Determine the Dihedral Angle Between the Two Planes

The dihedral angle is measured in the plane that is perpendicular to the line of

intersection. The dihedral angle (a) is equal to 2 Tan ' (1 / h cos ij;).

Step 6. Determine the Normal Force for Each Plane

Since the wedge is symmetric, the normal force on each plane will be the same. Thus,

the normal force for one plane is all that needs to be calculated. The breakdown of the forces

acting on a plane (due to weight of the wedge) is illustrated in Figure 5.5.

WCosi|f

a/2

N

<

A
Nj Sin all

Line of intersection

Figure 5.5 Components of forces as viewed
perpendicular to the line of intersection.

Utilizing limiting equilibrium principles and symmetry, the following equalities are

obtained:

2NiSin(a/2) = WCosilr

and

Ni = '/2WCosi|;/Sin(a/2)
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Step 7. Calculation of Area of Slide Plane

The area of each plane is calculated as follows:

Aj = 1 / (2 * Cos i|; * Sin (a/2)

Step 8. Determine the Normal Force for Each Plane Including Rockbolts

Ni(B) = ̂2 W Cos tjf / Sin (a/2) +'ANT Cos p / Sin (a/2)

Step 9. Determine the Factor ofSafety (With No Water Pressure)

Resisting Force 2Ni(B)Tan(|) + 2AiC
rb = =

Driving Force WSinv]/ - nTSinp

Step 10. Determine the Normal Forcefor Each Plane Including Water Pressure

Ni'=Ni(B)-UiAi

Step 11. Determination of Factor ofSafety Including the Effects of Water Pressure (u)

2NiTan(j) + 2AiC
FS — '

WSinv|/ - nTSinP

5.2.2 Verificatioii

The previous example was entered in WedgeSlip and the factor of safety acquired

for several different scenarios. These were compared with spreadsheet calculations based

on the previous formulas. Four iterations for each variable were run (with all other

variables being held constant) and results obtained. The following spreadsheet (Table 5.2)

shows the agreement between the two results and as a result, verifies the accuracy of

WedgeSlip for this simple example.
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Table 5.2 WedgeSlip verification exercise (see Table 3.2 for definition of variables).

12/28/98

h Vol Y 1 Wt. a Area 4>l c NlTl S P u 1 N' Fr 1 Fd FS FS

^WS)
1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 0 3.61 4.17 5.89 0.71 0.71

2 0.67 25 16.67 63.43 96.38 1.50 30 0 0 1 1 10 0 5.00 5.77 14.91 0.39 0.39

3 1.00 25 25.00 71.57 93.02 2.18 30 0 0 1 1 10 0 5.45 6.29 23.72 0.27 0.27

4 1.33 25 33.33 75.96 91.74 2.87 30 0 0 1 1 10 0 5.63 6.50 32.34 0.20 0.20

1 0.33 26 8.67 45.00 109.47 0.87 30 0 0 1 1 10 0 3.75 4.33 6.13 0.71 0.71

1 0.33 27 9.00 45.00 109.47 0.87 30 0 0 1 1 10 0 3.90 4.50 6.36 0.71 0.71

1 0.33 28 9.33 45.00 109.47 0.87 30 0 0 1 1 10 0 4.04 4.67 6.60 0.71 0.71

1 0.33 29 9.67 45.00 109.47 0.87 30 0 0 1 1 10 0 4.19 4.83 6.84 0.71 0.71

1 0.33 25 8.33 45.00 109.47 0.87 10 0 0 1 1 10 0 3.61 1.27 5.89 0.22 0.22

1 0.33 25 8.33 45.00 109.47 0.87 20 0 0 1 1 10 0 3.61 2.63 5.89 0.45 0.45

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 0 3.61 4.17 5.89 0.71 0.71

1 0.33 25 8.33 45.00 109.47 0.87 40 0 0 1 1 10 0 3.61 6.06 5.89 1.03 1.03

1 0.33 25 8.33 45.00 109.47 0.87 30 5 0 1 1 10 0 3.61 12.83 5.89 2.18 2.18

1 0.33 25 8.33 45.00 109.47 0.87 30 10 0 1 1 10 0 3.61 21.49 5.89 3.65 3.65

1 0.33 25 8.33 45.00 109.47 0.87 30 15 0 1 1 10 0 3.61 30.15 5.89 5.12 5.12

1 0.33 25 8.33 45.00 109.47 0.87 30 20 0 1 1 10 0 3.61 38.81 5.89 6.59 6.59

1 0.33 25 8.33 45.00 109.47 0.87 30 0 2 1 1 10 0 4.81 7.56 5.55 1.36 1.36

1 0.33 25 8.33 45.00 109.47 0.87 30 0 4 1 1 10 0 6.02 10.95 5.20 2.11 2.11

1 0.33 25 8.33 45.00 109.47 0.87 30 0 6 1 1 10 0 7.23 14.34 4.85 2.96 2.96

1 0.33 25 8.33 45.00 109.47 0.87 30 0 8 1 1 10 0 8.43 17.74 4.50 3.94 3.94

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 5 1 10 0 6.62 8.65 5.02 1.72 1.72

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 10 1 10 0 9.64 12.13 4.16 2.92 2.92

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 15 1 10 0 12.65 15.61 3.29 4.75 4.75

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 20 1 10 0 15.67 19.09 2.42 7.89 7.89

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 5 10 0 4.21 9.86. 5.72 1.72 1.72

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 10 10 0 4.21 14.86 5.72 2.60 2.60

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 15 10 0 4.21 19.86 5.72 3.47 3.47

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 20 10 0 4.21 24.86 5.72 4.35 4.35

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 20 0 4.18 5.83 5.55 1.05 1.05

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 40 0 4.08 5.71 5.25 1.09 1.09

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 60 0 3.91 5.52 5.03 1.10 1.10

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 80 0 3.71 5.29 4.91 1.08 1.08

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 1 2.74 3.17 5.89 0.54 0.54

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 2 1.88 2.17 5.89 0.37 037

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 3 1.01 1.17 5.89 0.20 0.20

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 4 0.14 0.17 5.89 0.03 0.03

h Vol y Wt. V a Area ^ 1 c N| T S p u N' Fr Fd FS FS
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5.3 Example Data (WedgeSlip)

5.3.1 Introduction

Several example cases of wedge sliding analysis were performed to further

validate the WedgeSlip program. The original data were hand plotted on a stereonet in

some cases. Then the data were entered into the WedgeSlip Version 1.3 program, results

obtained, and the geometry of the slope verified. Five of these examples are actually

programmed into WedgeSlip. They can be found under the "Data" pull-down menu in the

submenu "Examples". The following table gives details of each example including

source, input data and comparison between published and WedgeSlip results.
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Table 5.3 WedgeSlip Example Data.

ll&lmplSteJI liplii
9S;ilESii«^e
ISdiSiSieSIISI?'

' ̂

,^»'jisa?r2gslsK:

Limestone

Quarry,
Alabama, 1998

1-40 Wedge,
Russell Glass,
N.C.D.O.T.,

1997

Symmetric
Wedge,

Dr. Matthew

Mauldon, 1998

B.K. Low,
1997

TRB Special
Report 247,

1996

g3«r^5pf<pi|5?
Stptslil^ SI fys SI SI SI

-S" #^8.6
30 36 54.74 45 45

,V;K1< 244 250 315 105 265

71 61 54.74 70 48

iwaMl 343 161 45 235 168

iSlBil 0 0 0 12 10

lig^iisil
i;Sflcfe»SE2£w; 221 212 180 185 196

■S#4lllStelMS5i 54 76 90 16 76

227 212 0 185 196

10 200 10 30.55 30

'StPpasPW
30 30 30 30 35

30 30 30 20 35

0 0 0 24 20

0 0 0 48 10

iSS
VI t T''?i\ft"1 a® 0 0 0 66.7 0

- 1
"2 - lig 0 0 0 66.7 0

Y , • " 19% 27 160 25 25 25
<-i . «r-

;iilidin|i^ Single Plane
Shding on

Plane!

Double Plane
Sliding

Double Plane
Sliding

Double Plane
Sliding

Double Plane
Sliding

■pa^iis
VVedgeSlip)

1 0.95 0.71 1.32 1.18

tjEuiiisBii&^#| 1 ~ 0.71 '  1.32 1.23*

* The FS published in TRB was based on angles measured graphically from a stereonet.
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5.4 RockSlip

The verification method used for RockSlip is one of comparison with the

symmetric case used to verify WedgeSlip. The height of the block, h, and fiiction angle,

(j), are the two variables examined in this verification exercise. The shape of the slope

face triangle for each wedge was determined using the results in section 5.2.1. This

information was then input into RockSlip using a points file (*.pts). The points file is

accessed by going to File => Open Points. A dialog box will appear allowing the user to

browse for a points file. A points file was generated for this exercise based on the shape

of the slope face triangle. The points file contains coordinates of each of the points, firom

right to left, which define the multi-planar failure surface. The coordinate system used to

define the points is shown on the following page in Figure 5.6. The following spreadsheet

(Table 5.4) shows the results of this verification exercise.

->

Table 5.4 RockSlip verification exercise.

RockSlip Verification Exercise

4/19/99

h <|) FS "BSiWedgeSlip)' {̂RockSlip)

1 30 0.71 0.71 0.71

2 30 0.39 0.39 0.40

3 30 0.27 0.21 0.28

4 30 n  0.20 0.20 0.20

1 10 0.22 0.22 0.22

1 20 0.45 0.45 0.45

1 30 0.71 0.71 0.71

1 40 1.03 1.03 1.03
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RockSlip Version 1.3 Institute for Geotechnology, University of Tennessee. Knoxville ... H1BEII

I Profile Photograph
4.083333

X-Coordinates

.7708333

Y-Coordinates
_

Click on the photograph to define planes from right to left.

4715

a

life

Figure 5.6 Example of points file in RockSlip. Relative coordinates of picture box and
coordinate axes are shown.



Part VI

Algorithms and Code - PlaneSlip
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Algorithms and Code - PlaneSlip

Note: Program code appears in courier New lo point font and code

comments appear in Times New Roman 12 point font in Parts 6,7 and 8.

6.1 Geometry

Since PlaneSlip calculates the factor of safety based on the cross sectional

geometry of the slope (because a unit thickness of 1 is assumed). The following diagram

(hs - si sin ffj) cot

si sin a

hscota

LL

hs cot a, - LLsi cos g.
M

si
2r_ I __

b,

.a fi

he

hs -he

(hs - he) cot a

he cot a,

hc(cota2-cotai)

he cot (X2

Figure 6.1 Generalized cross-section showing all geometric quantities.

89



(Figure 6.1) shows a typical cross section and the quantities that are used to calculate

various lengths and ultimately the cross sectional area, volume, and weight of the block

of rock. Three linear values are required for the calculation of the area of the cross-

section; hs, the vertical distance from the lowest to the highest point of the cross section;

LL, the horizontal distance from the lowest to the highest point of the cross section; he,

the height of tension crack.

The formulae for these quantities are as follows:

hs=fl-sina4 + sl-sina3

LL = fl • cosa4 + si • cosa3

(LL-hs)cotd2
(cotai -cota2)

The area of the cross-section is now found by taking the large rectangle with dimensions

LL X hs and subtracting from it the triangles bj - b4, and the rectangles Cj and Cj. In

mathematical form:

Cross-sectional area, a = (LL - hs) - bj - Cj - b2 - b3 - C2 - b4

where,

(hs- slsina3)^
hi = r

2tana4

(si sing 3)(hs- si sing 3)
tang4

(si smg3)(slcosg3)
b2= 2

hc^

2tangi

C2 = (hs- hc)-^^—
tang 1

(hs- hc)^
b4 = "T

2tang2 90



6.1.2 Program Code

hs = fl * Sin(q4) + si * Sin(q3)

hs = the vertical distance from the lowest to the highest point of the cross section.

LL = fl * Cos(q4) + si * Cos(q3)

LL = the horizontal distance from the lowest to the highest point of the cross section.

he = (LL - hs / Tan(q2)) / (1 / Tan(ql) - 1 / Tan(q2))

he = the height of tension crack.

Calculates the total volume of rock and its weight.

Rem calculate the volume (a) of block,

a = LL * hs

a = a - (( (hs - si * Sin(q3)) 2) / (2 * Tan(q4))) hi

a = a - ({si * Sin(q3)) * (hs - si * Sin(q3)) / Tan(q4)) cl

a = a - ((si ^ 2) * Sin(q3) * Cos(q3)) / 2 b2

a = a - (he ^ 2) / (Tan(ql) * 2) b3

a = a - (hs - he) * he / Tan(ql) c2

a = a - (hs - he) 2 / (Tan(q2) * 2) b4

Rem calculate the weight of block.

a = a * wr wr—rock imit weight
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6.2 Water Force

We consider four cases for the water pressure problem in plane failure: two

extreme cases, drained and undrained; an intermediate partially drained case; and a case

with negative drainage impedance. The drained case has a fully drained toe and the

imdrained case has no drainage at the toe. For the intermediate,case, (between drained

case and undrained case), we use a parameter called "Drainage Impedance" to adjust

drainage percentage at the toe. Negative drainage impedance is used to model cases

where water reaches atmospheric pressure before it reaches the toe of the slope. This can

be a result of erosion or block rotation opening up the slide plane. The geometry of a

typical plane failure is shown in Fig.6.2(a). We assume that water pressure has a

distribution shown in Fig. 6.2(b). In Fig. 6.2(b), line deafo illustrates the pressure

distribution in the drained case, and deafgo for the Winter case and deafg'o for the

partially drained case. When Drainage Impedance is equal to 100%, the water pressure

1 V

or Drained

jy Undrained

\/ ' _ _ Partially
g  Drained

(a) (b)

Figure 6.2 Cross-section of a plane slide showing geometric variables.
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distribution is equivalent to that of the undrained case. When Drainage Impedance is

equal to 0%, the water pressure distribution is equivalent to that of the drained case. In

the discussion of wedge failure and prismatic failure, we still use Drainage Impedance to

describe the intermediate case. Later we don't repeat this again. Now let's calculate the

total water force in the above three cases.

6.2.1 Drained Case

We use V to represent the total water force acting on line ad, U the total force on

oa. Let Y denote the unit weight of water, and let z denote the height of water in the

tension crack. Then we have

\V\ = V2Xzxadx r (6.1)

\ U\ = V2 X z X oa X y (6.2)

= -(V2 X zx ad X y)x sin a ] (6.3)

Vy = (y2x zx adx y)x cos a, (6.4)

= -('/2 X z xoa X y)x sin (6.5)

Uy = (V2 xzx oax y) X cos V.2 (6.6)

The magnitude of the total water force, acting on the block is

1  I=/•( F,+ / + r F,+1;,

= (z X y/2) X [ (ad X sin Uj + oa x sin + (ad x cos cti + oa x cos

= (z X y/2) X od. ' (6.7)

Using the result,

+ UJ /(Vy+Uy) = (ad X sin + oa x sin 0.2) / (ad x cos tty + oa x cos a^)

= tan (p), we note that the total water force
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(a) (b) (c)

Figure 63 Cross-section showing independence of F® on shape of block oabc.

is perpendicular to od. Furthermore, the magnitude of the water force depends only on the

height, z, of water in the tension crack and the length of od. This is an interesting result. It

means that if z and line od are not changed, the shape of block oabc has no influence on

F®, i.e. F® for several shapes in Fig.6.3 has the same value.

6.2.3 Undrained Case

For the undrained case, we can divide the water force into two parts: one is just

the water pressure of the drained case, another is that formed by the water pressure of

h.ofg in Fig. 6.2(b).

Total water force formed by the part of Lofg in Fig. 6.2(b), we name it F', is

equal to

I F' I = ̂ X x(hs -he + z) X (hs- he)/ sin 0^2 (6.8)

where hs - he + z is the pressure head at point o and (hs - he) /sin 0^2 is the length oa of

the slide plane.

94



From the geometry in Figure 6.1, we have

hs = S X sin ̂ 4 + Lx sin and ^

hc = (Sx sin a^ + Lx sin a3)(l - l/(n-m)) -n(Sx cos a^+Lx cos a^(l - n/(n-

m))

the direction of F is perpendicular to line oa, therefore the total water force, F", for the

undrained case is

pv = p' (6.9)

6.2.4 Partially Drained Case

In this case, we keep the water force of the drained case as a basic part, which

doesn't change with Drainage Impedance, and just use Drainage Impedance to modify F'

in Eq.(6.8) by formulae

poi=p^ X ̂  (6.10)

where is the water force of Lofg including the modification for Drainage Impedance.

/is Drainage Impedance and has a range of 0 to 100% for positive values.

Then the total water force F is

p=:pD + poi (6,11)

6.2.5 Negative Drainage Impedance

Negative drainage impedance is used to model situations where water reaches

atmospheric pressure at a point back into the slope along the slide plane. PlaneSlip

handles the calculation of the appropriate uplift force on the slide plane by modifying the
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point where the pressure distribution goes to zero according to the amount of drainage

impedance. For instance, if the drainage impedance is set to - 50%, then the water

pressure distribution goes to zero at a point halfway along the length of the slide plane. In

turn this reduces the magnitude of the water force acting on the slide plane and increases

the factor of safety. Negative drainage impedance has a range of -1% to -90%.

6.2.6 Program Code

The code used in PlaneSlip to calculate the water force is listed below. Overall,

the code follows the algorithms outlined in the previous sections for calculating the water

force in each case. Some differences exist in the variable names and the order in which

quantities are calculated. Also, the code contains the logical operators used to distinguish

between the different cases and in some instances, the different slope geometries that are

possible.

Rem if zw=0, no water

If zw = 0 Then

' GoTo 100

End If

If zw > he Then

GoTo 200

Old code: GoTo 50

End If
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Rem calculate water force

If xi >= 0 Then' This block is for drainage impedance >= 0

Lc = zw / Tan(ql) + (hs - he) / Tan(q2)

'Lc is the length of line od in Figure 6.3;

'also Xd in alternate coordinate system

qL = (hs - he + zw) / Le

qL = Atn (qL) ' dip angle of water plane od

' qL is the dip angle of water plane od in Figure 6.3

Le = Sqr(Lc ^ 2 + ((hs - he + zw) ^2)) 'length of od

al = Lc * zw / 2 * ww

' = 1/2 * unit weight of water * zw = fictitious force, W, on water plane

rn = rn - al * Cos (qL - q2) ' normal force on sliding plane

rt = rt + al * sin(qL - q2) ' shear force on sliding plane

Rem water force in winter

'xi = drainage impedance

rn = rn - ((hs - he + zw) * xi * (hs - he) / Sin(q2) / 2 * ww)
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Else ' This block is for drainage impedance < 0.

Dim Isp, u, V, vn, vt, guv As Single

' Isp = length of slide plane, u = uplift force on sliding plane

' V = force on tension crack, vn = normal (to sliding plane) component of v

' vt = tangential (to sliding plane) component of v, quv = angle between forces u and v

Isp = (((hs - he) ̂ 2) + {((hs - he) / Tan(q2)) ^2)) ̂  (1/2)

u = ((1 + xi) * Isp * zw * ww) / 2

V = ((zw 2) * ww) / 2

quv = qll - q22

quv = quv * r

vn = V * Cos(quv)

vt = V * Sin(quv)

rn = rn - u - vn ' nomial force

rt = rt + vt ' driving force

End If

6.3 Factor of Safety

6.3.1 Limiting Equilibrium

The term "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. Thus, one must define an index which

describes the relationship between driving and resisting forces for each geometric and

mechanical situation in a rock slope. This is traditionally done using an index called the

Factor ofSafety. The Factor of Safety is most commonly defined as the ratio of the total
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resisting force to the total driving force. For plane sliding, the equation for calculating the

Factor of Safety is as follows:

cA + (W cos v|/n - U - V sin V|; D ) tan <))
FS = ^ ^ (6.12)Wsinvi/p+Vcosyp ^ ^

Where FS = factor of safety, c = cohesion, A = area of failure surface, W = weight of

rock, i|;p = slope of failure plane, U = uplift water force on failure plane, V = water force

on tension crack, and (j) = fiiction angle. All notation is consistent with Hoek & Bray

(1981).

The above equation includes the effects of water pressure but does not address the

effects of rock reinforcement. If a rock bolt or cable is oriented as shown in Figure 2.4,

then the equation is modified as follows:

cA + (Wcosv|/p -U-Vsin\i/p H-N^Fb cosP)tan(l) + NbSb /S^
FS = (6.13)

Wsinv|/p + Vcosvi/p -N^F], sinP

Where Nb = nmnber of rockbolts, Fb = cable or bolt tension, Sb = shear strength of bolts,

Sh = hprizontal spacing of rockbolts and p = angle cable or bolt makes with normal to

failure plane. Note that P can be calculated indirectly from the dips of the face and failure

plane and the angle, 0, that the rockbolt makes with the normal to the face (this quantity

is easily measured in the field and is also the type of information that needs to be

conveyed to a driller who is installing the rockbolts). The following is the formulation of

P that is used in the PlaneSlip computer code:

P = \|/f-v|/p-e (6.14)
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T

Embedment
Length

Figiire6.4 Plane slide schematic defining the
orientation of a lock bolt or cable.

6.3.2 Program Code

The code used in PlaneSlip to calculate the factor of safety is listed below.

Overall, the code follows the algorithms outlined in the previous section for calculating

the factor of safety in each case. Some differences exist in the variable names and the

order in which quantities are calculated. Also, the code contains the logical operators .

used to distinguish between the different cases and in some instances, the different slope

geometries that are possible.

Rem calculate the factor of safety

Dim £0, fs2, £s5 As Single

100 If rt <= 0 Then GoTo 200

fO = (hs - he) * c / Sin(q2) + rn * Sin(qc) / Cos(qc) + rtl + SF *

(NB - jj)

fs = fO / rt

If fs < 0 Then fs = 0
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Formats the factor of safety to 2 decimal places and 5 decimal places.

fs2 = Format(fs, "0.00")

fs5 = Format(fs, "0.00000")

Rem display information on input data(whether they are correct?)

200 picBox.PSet (0, 0), vbWhite

If he < 0 Then

txtResuits.Text = "data entry wrong"

Exit Sub

Else

If rt <= 0 Then' driving force acts upward, very safe!

txtResults.Text = "driving force acting upward (factor of safety not

defined)"

Exit Sub

End If

Display factor of safety.

txtResults.Text = "Factor of Safety = " & CSng(fs2) & " (" &

CSng(fs5) & ")"

End If
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PARTVn

Algorithms and Code - WedgeSlip
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Algorithms and Code - WedgeSlip

Note: The coordinate system used is y is north, x is east and z is vertically up. The

variables used in the computer code correspond to the variables used by Hoek &

Bray m. Rock Slope Engineering (1981). The following is a list of those variables.

1. a = Dj = unit normal vector for plane 1 (positive up)

2. b = = unit normal vector for plane 2 (positive up)

3. d = Uj = unit normal vector for plane 3 (upper ground surface) (positive up)

4. f = 04 = unit normal vector for plane 4 (slope face) (positive up)

5. fg = 115 = unit normal vector for plane 5 (tension crack) (positive up)

6. t = rock bolt vector (positive down)

7. e = external force vector (positive down)

8. g = f X a = n4 X ni = sin e„i,„4

9. g5 = fsxa = nsxni = sine„i.„5

10. i = b X a = n2 X ni = sin0„i n2

11. j = f X d = n4 X n3 = sine^,„4

12. jg = fg X d = ng X Dg = SlU

13. k = i X b = (b X a) X b = a-b(a • b) = a-b • r

14. I = i X a = a X (b X a) = b - a(a • b) = b - a • r

15. m = g • d = f X a • d = n4 X nj • n3= sin 0,54331 * sin 0„,,„4 * sin 0„i„3

16. mg = gg • d = fg X a • d = Dg X Hi • Dg = sin 0115.13, * sin 0„i.^ * sin 0„i.„5

17. n = b • j = b • f X d = Dg • n4 X n3= sin 0^.„4 * cos 0,34^
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18. Dg = b • jg = b • fg X d = Dij • ng X nj = sin 0^.^ * cos 0i35.n2

19. p = i • d = b X a • d = X n, • n3= sin 0^1 * cos 0ii2.n3

20. q = b-g =b-fx a = n2-n4xni = sin0„i.„4*cos0„4^

21. qg = b • gg = b • fg X a = n2 • Hg X ni = sin 0„i „5 * cos 01,5.^

22. r = a • b = cos 0„i.^

23. s = a • t = cos 0„i t

24. V = b • t = cos 0„i t

25. w = b • t = sin 0„i „2 * (1) * cos 0ii2.t

26. Se=NOT USED

27. Ve= NOT USED

28. w,= NOT USED

29. Sg = a • fg = cos 0„i.^

30. Vg = b-fg=cos0^„5

31. Wg = i • fg = sin 0„i „2 * (1) * cos 0ii2.„5

32. A = i • g= sin 0„,.^* sin 0„i.„4* cos 0112.114

33. Ag = i • gg = sin 0„i„2 * sin 0„i.„5 * cos 0112.115

34. e = f-fg=cos0„4.„5

35. R=(l-r2f==|sin6„i.^|

36. p = (l/R^)*(nq/ |nq|) =±1 / sin^ 0„i.^

37. p = (l/R^) * (mq/ |mq|) = ±1 / sin^ 0„i.^

38. v = (l/R)*(p/ IpI) =±1/|sin0„,„2|

39. G= |gl = |sin0„i.„4|

40. Gg= |gg| = |sin0„i.„5|
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7.1 Geometry

WedgeSlip calculates two major sets of data: The coordinates of important points

on the wedge and areas of the faces of the wedge.

7.1.1 Coordinates

Point coordinates are determined by using the unit normal vectors which describe

each plane in the wedge in simultaneous plane equations which are solved to jSnd the

intersection point of the three planes. The formulation for point G will be presented here

as an example calculation.

Point G

Plane 6 is defined as a vertical plane through 1^2 (shaded plane in Figure 3.4).

The unit normal vector for Plane 6 is as follows:

/  \ {^6 = (^X'^y^z) =
rly+ii

/K

> X

Figure 7.1 Coordinate axes
showing relationship between i and
n<
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Coordinates of Point G = Intersection of planes 3, 4 & 6

6^X y ^

Coordinates of Point G =

Using Cramer's Rule,

0-ly ix

fvX fyy
0  0

fzz = 0

1  H

A = fx fy fz
0  0 1

Ai =

0  ix

0  fy
H 0

-iy(fy)-ix(fx)

= ix(fzH)

A2 =

-iy 0 0

fx ® fz
0  H 1

= iy(fzH)

X coord G =
_

X coord G =

 Ai _ -ixfz
A  iyfy+ixfx

•H

-U

fx +fy

A2

^y
•H

y_ coord_ G = —— = x_ coord_ G • 7=^

z coord G = H

Point G (altemative solution, used in conjimction with previous equation to obtain

coordinates of point G)
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dxX dyy dzZ H2

fxx fyY fzz= 0
6xX 6yy 6zZ 0

Plane 3

Plane 4

Plane 6

A =

dx dy dz

-iv

Ai =

A2 =

A3 =

H2
0

0

^x

-iv

^x

-iv

^z

ix 0

dy dz

fy fz
ix 0

H2 d,

0

0

-

^z

0

 ̂x^z^x 'iyfz^y '^z(fx^x ^y^y)

= H2(-fzix)

H2

X coord G =
Ai

= -H2(fziy)

= H2(fxix + fyiy)

^  dxfzix+dyfziy-dz(fxix + fyiy)
—i f H

From previous calculations, x_coord_G = r
(iyfy+ixfx)

Equate the two formulas for x_coord_G to obtain,

^  (~^xfzH)-|dxfzix +dyfziy -dz(fxix "^^y^y)]
(iyfy+ixfx)'(fzix)

7.1.1.1 Program Code

= -fz * HHV / (fx + fy * iy / ix)

* x_coord_g

/  (fx + fy * iy / ix)

H2 = H2 - dy * iy * fz / ix / (fx + fy * iy

x_coord_g

:oord_g

H2 = -dx * fz

y_coord_g = iy / ix

/ ix) + dz
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7.1.2 Areas

The formulas used to calculate the area of different wedge faces are based on

methods outlined in Hoek & Bray's discussion of wedge failure (1981). The following is

a proof of the area calculation for plane 1 (Triangle AOC).

Triangle AOC (Area of Plane 1)

[12113

9ii3T41 "112141

Figure 7.2 Schematic of plane 1 showing
geometric quantities.

1. Calculate the three included angles.

|(n4 X nj) X (ni x ns)] = sinGn^.m sin0ni.n3 sm0i4j.i,3
Also,(n4 X n^) x (nj x n3) = ni(n4 • n^ x n3) - n3(ni • nj x n4) = ni(n4 • n^ x n3) = n^m

••• H = sin0n^.ni sin0ni.n3 and m = (n4 • ni x n3)

|(n2 X ni) X (ni x ns)] = sin0n2.ni sin0ni.n3 sin0i2i.Ii3
Also,(n2 X n^) X (ni X n3) = ni(n2 • n^ x n3) = n^p
•■• Ip| = sin0n2.nisin0ni.n3sin0i2,.i,3 andp = (n2-ni xn3)
|(n2 X ni) x(ni x n4)| = sin0n2.ni sin0n,.n4 sin0i2j.i,4
Also,(n2 X ni) x (nj x n4) = ni(ni •n2 x n4) = njq

|q| = sin0n2.ni sin0ni.n4 and q = (ni •n2 x n4)
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2. Calculate the side lengths.

By definition (line 43, H&B) h = H, / | |. Note that | g^ | = g sin x|fg where ij/g is the

plunge of g.

= IOAI h, so that
|gz| sincpg |g| sin0n4.nj

|OA| = h-sinen^.ni

lod hcinO 5! sme„,„3 sine„,n,
sm6,3,,,3 sin9„3„3 sine„,„, p

|0Cl = -ysme„3„,

|A^ = |0A|.^^ = hsin6„,„, sin9„3„,sin9„,„3
sin0i2iii3 ^ ^ sm0n2ni sm0n4ni P

|AC| = ̂sin0nin3

3. Area of triangle AOC.

AreaAOC =-|OAp =-|0A|^-!^—2' smei,3i3, 2' I p sin2 9„3„,
Substituting the previous definition of |0A|,(|0A| = hsin0n^ijj)

Aoc=lh2i!!l^i!!i
^  sin P

AOC=i^
2p

109



7.1.2.1 Program Code

A1 = (Abs(m * g) * h ^ 2) - (Abs(m5 * q5) * h5 ^ 2)

A1 = A1 / (2 * Abs(p))

7.2 Water Force

The method used in WedgeSlip to calculate the average water pressure on planes 1

and 2 is taken from Hoek & Bray (1981). The pressure distribution can be visualized as a

pyramid on each plane. The formula for the average water pressures, u, and Uj, is as

follows: 1

ui = U2 = - X Tw X V2J
_ (Yw X H)

(7.1)
0

7.2.2 Program Code

The code used in WedgeSlip to calculate the water force is listed below. Overall,

the code follows the algorithms outlined in the previous section for calculating the water

force. Some differences exist in the variable names and the order in which quantities are

calculated. Also, the code contains the logical operators used to distinguish between the

different cases and in some instances, the different slope geometries that are possible,

rw = unit weight of water, HHV = H

ul = (rw X HHV) / 6

u2 = (rw X HHV) / 6
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7.3 Factor of Safety

7.3.1 Limiting Equilibrium

The term "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. Thus, one must define an index which

describes the relationship between driving and resisting forces for each geometric and

mechanical situation in a rock slope. This is traditionally done using an index called the

Factor of Safety. The Factor of Safety is most commonly defined as the ratio of the total

resisting force to the total driving force. For wedge sliding, the equation for calculating

the Factor of Safety is as follows:

PS ̂  (Ni + N2)tan(|) + (ciAi + C2A2) ̂
W*Sin(pi ^

where Nj and Nj are the normal forces on planes 1 and 2, respectively, Cj and Cj are the

cohesive strengths of planes 1 and 2, A, and Aj are the areas of planes 1 and 2, W is the

weight of the wedge and ij;; is the plunge of the line of intersection. If water pressure and

rock bolts are included the factor of safety equation becomes:

rc _ [(Nl - U1 Ai) + (N2 - U2A2) + NbFb]tan(j) + NbSb + (ciA] + C2A2)
TrTTF. (7.3)W*Sm9j

where Uj and Uj are the average water pressures on planes 1 and 2, N,, is the number of

rock bolts, F^ is the tensile strength of the rock bolts and is the shear strength of the

rock bolts.

Ill



7.3.2 Program Code

The code used in WedgeSlip to calculate the factor of safety is listed below.

Overall, the code follows the algorithms outlined in the previous section for calculating

the factor of safety in each case. Some differences exist in the variable names and the

order in which quantities are calculated. Also, the code contains the logical operators

used to distinguish between the different cases and in some instances, the different slope

geometries that are possible.

Effective normal reactions on planes 1 and 2 assuming contact on both planes.

100 Dim Nl, N2 As Single

Notation used in H&B;

Nl = cw * kz + T * (r * V - s) + E * (r * ve - se) + cv * (r * v5 - s5)

Nl =rho*Nl-ul *A1

N2 = cw * zz + T * (r * s - v) + E * (r * se - ve) + cv * (r * s5 - v5)

N2 = mu * N2 - u2 * A2

c

I  f

Ni means the same as in H&B (effective normal reactions).

Nl = cw * kz + T * (r * V - s)

Nl = rho * Nl - Ul * A1

N2 = cw * zz + T * (r * s - v)
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N2 = mu * N2 - U2 * A2

Factor of safety when NKO AND N2<0 (no contact maintained).

Dim messagel, message2 As String

messagel = ""

If N1 < 0 And N2 < 0 Then

fs = 0

messagel = "Normal forces are negative"

message2 = "on planes 1 & 2."

End If

If N1>0 AND N2<0, contact is maintained on plane 1 only and the factor of safety is

calculated as follows.

If N1 > 0 And N2 < 0 Then

From H&B:

cna = cw*az-T*s-E*se-cv*s5-u2*A2*r

csx = "(T * tx + E * ex + cna * ax + v * f5x + u2 * A2 * bx)

csy = -(T * ty + E * ey + cna * ay + v * f5y + u2 * A2 * By)

csz = "(T * tz + E * ez + cna * az + v * f5z + u2 * A2 * bz) + cw
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csa = Sqr(csx ̂  2 + csy ̂  2 + csz 2)

cqa = (cna - ul * Al) * Tan(phil) + cl * A1

All variables mean same as in H&B.

Dim cna, cna2, csx, csy, csz, csa, cqa As Single

sliding_mode = 1 '

cna = cw*az-T*s - ((U2 * A2 * r) * (p / Abs(p)))

csx = "(T * tx + cna * ax + ((U2 * A2 * bx) * (p / Abs(p))))

csy = "(T * ty + cna * ay + ((U2 * A2 * by) * (p / Abs(p))))

csz = "(T * tz + cna * az + ((U2 * A2 * bz) * (p / Abs(p)))) + cw

NOTE: This section of the code differs from the original H&B code. The H&B code

produces errors for the case of single plane sliding with water pressure because it does not

differentiate between acute and obtuse blocks. Block theory is used here to find the

removable block and to detemiine whether the block is acute or obtuse.

If JPDesignation = 0 Then

cna =cw*az-T*s- (U2 * A2 * r)

csx = - (T * tx + cna * ax + (tJ2 * A2 * bx) )

csy = -(T * ty + cna * ay +- (U2 * A2 * by))

csz = -(T * tz + cna * az + (U2 * A2 * bz)) + cw

End If
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If JPDesignation = 1 Then

cna =cw*az-T*s+ (U2 * A2 * r)

csx = - (T * tx + cna * ax - (U2 * A2 * bx))

csy = - (T * ty + cna * ay - (U2 * A2 * by))

csz = -(T * tz + cna * az - (U2 * A2 * bz)) + cw

End If

csa = Sqr{(csx ^ 2) + (csy ^ 2) + (csz 2)) 'driving force

cga = (cna - XJl * Al) * Tan(phil) + cl * A1 + SF ' resisting force

If csa <= 0 Then

messagel = "Driving force is upward"

message2 = "or equal to 0!"

Else

fs = cqa / csa

End If

If fs < 0 Then

fs = 0

End If

End If

If N1<0 and N2>0, contact is maintained on plane 2 only and the factor of safety is

calculated as follows.

If N1 < 0 And N2 > 0 Then
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FromH&B:

cnb = cw * bz - T * V - E * ve - cv * v5 - ul * A1 * r

csx = "(T * tx + E * ex + cnb * bx + cv * f5x + ul * A1 * ax)

csy = "(T * ty + E * ey + cnb * By + cv * f5y + ul * A1 * ay)

csz = "(T * tz + E * ez + cnb * bz + cv * f5z + ul * A1 * az) + cw

csa = Sqr(csx ̂  2 + csy ̂  2 + csz ̂  2)

cqa = (cnb - u2 * A2) * Tan(phi2) + c2 * A2

All variables have same meaning as in H&B.

Dim cnb, cs, eg As Single

sliding_mode = 2

OLD CODE

cnb ==cw*bz-T*v - ((Ul * A1 * r) * (p / Abs(p)))

csx = "(T * tx + cnb * bx + ((Ul * Al * ax) * (p / Abs(p))))

csy = "(T * ty + cnb * by + ((Ul * Al * ay) * (p / Abs(p))))

csz = "(T * tz + cnb * bz + ((U1 *A1 *az)*(p / Abs(p)))) + cw

If JPDesignation = 0 Then

cnb =cw*bz-T*v- (Ul * Al * r)

csx = -(T * tx + cnb * bx + (Ul * Al * ax))
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csy = -(T * ty + cnb * by + (U1 * A1 * ay))

csz = -(T * tz + cnb * bz + (U1 * A1 * az)) + cw

End If

If JPDesignation = 2 Then

cnb = cw * bz - T * V + (U1 * A1 * r)

csx = -(T * tx + cnb * bx - (U1 * A1 * ax) )

csy = -(T * ty + cnb * by - (U1 * A1 * ay))

csz = -(T * tz + cnb * bz - (U1 * A1 * az)) + cw

End If

csa = Sgr(csx 2 + csy 2 + csz '' 2)

cga = (cnb - U2 * A2) * Tan(phi2) + c2 * A2 + SF

If csa <= 0 Then

messagel = "Driving force is upward"

message2 = "or egual t'O 0!"

Else

fs = cga / csa

End If

If fs < 0 Then

f s = 0

End If

End If

Contact on both planes.
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IfNl > 0 And N2>0 Then

cs = nu * (cw * iz - T * w -e*we-cv*w5) (from H&B)

,  ,sliding_mode = 0

cna = cw * az - T * s - U2 * A2 * r

csx = -(T * tx + cna * ax + U2 * A2 * bx)

csy = -(T * ty + cna * ay + U2 * A2 * by)

csz = -(T * tz + cna * az + U2 * A2 * bz) + cw

cs = nu * (cw * iz - T * w)

cq = N1 * Tan(phil) + N2 * Tan(phi2) + cl * A1 + c2 * A2 + SF

If cs <= 0 Then

messagel = "Driving force is upward"

message2 = "or equal to 0!"

Else

fs = cq / cs

End If

If fs < 0 Then

f s = 0

End If

End If
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Report sliding mode, plunge and trend of line of intersection, and the dihedral angle in

the text box, "txtinfo".

Dim fs2, fs5 As Single

If JPDesignation = 0 Then

txtinfo.Text = "Plunge of Line of Intersection = " & CSng(psiii) &

vbCrLf & "Trend of Line of Intersection = " & CSng(alphaii) & vbCrLf &

"Dihedral Angle = " & CSng(dihedral1) & vbCrLf & "Area of Plane 1 = " &

CSng(Al) & vbCrLf & "Area of Plane 2 = " & CSng(A2) & vbCrLf & "Volume

of Wedge = " & CSng(Vol) & vbCrLf & "Weight = " & CSng(cw) & vbCrLf &

"Effective Normal Reaction, N1' = " & CSng(Nl) & vbCrLf & "Effective

Normal Reaction, N2' = " & CSng(N2) & vbCrLf & "BP 0011 is the removable

block." & vbCrLf & "JP 00 is the removable joint pyramid."

End If

If JPDesignation = 1 Then

txtinfo.Text = "Plunge of Line of Intersection = " & CSng(psiii) &

vbCrLf & "Trend of Line of Intersection = " & CSng(alphaii) & vbCrLf &

"Dihedral Angle = " & CSng(dihedral1) & vbCrLf & "Area of Plane 1 = " &

CSng(Al) & vbCrLf & "Area of Plane 2 = " & CSng(A2) & vbCrLf & "Volume

of Wedge = " a CSng(Vol) & vbCrLf & "Weight = " & CSng(cw) & vbCrLf &

"Effective Normal Reaction, N1' = " & CSng(Nl) & vbCrLf & "Effective

Normal Reaction, N2' = " & CSng(N2) & vbCrLf & "BP 0111 is the removable

wedge." & vbCrLf & "JP 01 is the removable joint pyramid."

End If

If JPDesignation = 2 Then

txtinfo.Text = "Plunge of Line of Intersection = " & CSng(psiii) &

vbCrLf & "Trend of Line of Intersection = " & CSng (alphaii) & vbCrLf &.
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"Dihedral Angle = " & CSng(dihedrall) & vbCrLf & "Area of Plane 1 = " &

CSng(Al) & vbCrLf & "Area of Plane 2 = " & CSng(A2) & vbCrLf & "Volume

of Wedge = " & CSng(Vol) & vbCrLf & "Weight = " & CSng(cw) & vbCrLf &

"Effective Normal Reaction, N1' = " & CSng(Nl) & vbCrLf & "Effective

Normal Reaction, N2' = " & CSng(N2) & vbCrLf & "BP 1011 is the removable

wedge." & vbCrLf & "JP 10 is the removable joint pyramid."

End If

fs2 = Format(fs, "0.00")

fs5 = Format(fs, "0.00000")

Display factor of safety or error messages.

If messagel = "" Then

If sliding_mode = 0 Then

Textl.Text = "Factor of Safety = " & CSng{fs2) & " (" & CSng(fs5)

&  :;) "

Text2.Text = "Double Plane Sliding"

ent = ""

End If

If sliding_mode = 1 Then

Textl.Text = "Factor, of Safety = " & CSng(fs2) & " (" & CSng(fs5)

Sc ")"

,Text2.Text = "Single Plane Sliding on Plane 1"

ent = ""

End If

If sliding_mode = 2 Then
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Textl.Text = "Factor of Safety = " & CSng(fs2) & " (" & CSng(fs5)

& ") "

Text2.Text = "Single Plane Sliding on Plane 2"

ent = ""

End If

Else

Text2.Text = messagel

Textl.Text = message2

End If

Exit Sub

200 Textl.Text = ent

Text2.Text = ""

Exit Sub

300 Textl.Text = "wrong data entry"

Text2.Text = ""

Exit Sub

End Sub
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PARTVin

Algorithms and Code - RockSlip
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Algorithms and Code - RockSlip

8.1 Geometry

Several assumptions (q3 = q2, q4 = ql) are made regarding the geometry of the

rock block in RockSlip. These assumptions result in the cross-section of the block being a

parallelogram. Gaussian Numerical Integration is used to calculate the volume of the

block which is used to obtain the total weight of the block.

i

8.1.1 Program Code

Read parameters from text boxes. These parameters will be input in fOutcrop form.

Dim rho, ql, q3, q2, q4, wf, phip As Single

rho = PI / 180

ql = Tan (CD * rho) * Cos (Abs (ODD - TR) * rho)

ql = Atn(Abs(ql)) '(F^g It))

q2 = PL * rho '(Fig It)}

q3 = q2 '(in current version of program, Fig lb)

q4 = ql '(in current version of program, Fig lb)

phip = phi * rho

wf = wfo / 100'drainage impedance in decimal form

Determination of the lowest point (xlow, ylow) of true section.

Dim ylow, xlow As Single
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Dim numi As Integer

ylow = YT{1)

xlow = XT(1)

For numi = 2 To numpoint

If ylow < YT(numi) Then

ylow = YT(numi)

xlow = XT(numi)

End If

Next numi

Determination of some geometry parameters. Refer to variables diagram 1(b) for fl, hs,

he. Fdl is the slope of line fk (Fig la).

Dim fdl, fd2, fl, hs, he, q5 As Single

fdl = (YT(numpoint) - YT(1)) / (XT(numpoint) - XT(1))

fd2 = YT(1) - fdl * XT(1)

fl ='fdl * xlow + fd2

fl = (ylow - fl) / Cos(3.14159 / 2 - g4 + g2)

hs = fl * Sin(g4) + si * Sin(g3)

he = fl * Cos(g4) + si * Cos(g3) \

he = he - hs / Tan(g2)

he = he / (1 / Tan(gl) - 1 / Tan(g2))

gS = 3.14159 / 2 - g2 + g3

Refer to variables diagram 1(b) for LO, hO, LI, L3.

Dim LO, ho, LI, L3, LQ, rn, rt As Single

/

Dim Msg As String
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LO = fl * Sin(q4 - q2)

ho = he * Sin{ql - q2) / Sin(ql)

LI = LO * Cos(q4 - q2)

L3 = hO / Tan(ql - q2)

LQ = si * Cos(q2 - q3)

rn = 0

rt = 0

Determination of inner section(which is parallel to true section) / variables diagram la.

Dim i, 11, XT0(250), yT0{250), x00{2), yOO(2) As Single

Dim numlnO As Single

Checks if LI and si are parallel (var. diagram lb).

If q2 - q3 = 0 Then 'this is assumed in present model.

For 11 = 1 To numpolnt

XTO(11) = XT(11)

YTO (11) = YTdl)

Next 11

xOO (1) = XTO(1)

x00(2) = XTO(numpolnt)

yOO (1) = YTO(1)

y00(2) = YTO(numpolnt)

numlnO = numpolnt

End If
/

If q2 - q3 = 0 Then GoTo 15
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Between two points i & j (Fig la), which one is lower? note: yOO(l) = i and y00(2) = j on

variables diagram la.

15 If yOO(l) >= y00(2) Then 'j is lower

yinO = yOO(1)

xinO = xOO(1)

Else 'i is lower

yinO = 'y00(2)

xinO = x00(2)

End If

Prepare for the calculation of block weight.

90 If q2 = q3 Then GoTo 110 'current assumption

(

Detemiination of block weight (case 2). q2=q3

The first block of code detennines the length between the firont and back faces of the

block. Uses the equation of a plane : z = Ax + By + C , where z is desired length, A is

coeal&2, B is coebl&2, C is coecl&2 (coefficients). Here we solve for z (a length).

This calculates the total block volume. This calculation was designed to handle the

general case (ql o q4), using Gauss points. Gauss method is not really necessary for our

assumption ql=q4.

110 coebl = (YT(1) - YT(numpoint)) / (XT(1) - XT(numpoint))

coebl = coebl - (ylow - YT(numpoint)) / (xlow - XT(numpoint))

coebl = -L3 / (xlow - XT(numpoint)) / coebl

coeal = -(YT(1) - YT(numpoint)) / (XT(1) - XT(numpoint)) * coebl
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coed = -coeal * XT(1) - coebl * YT(1)

coeb2 = (YT(1) - YT(numpoint)) / (XT(1) - XT(numpoint))

coeb2 = coeb2 - (ylow - YT(numpoint)) / (xlow - XT(numpoint))

coeb2 = -LI / (xlow - XT(numpoint)) / coeb2

coea2 = -(YT(1) - YT(numpoint)) / (XT(1) - XT(numpoint)) * coeb2

coec2 = si - coea2 * XT(1) - coeb2 * YT(1)

Dim ccl, cc2, cc3 As Single

ccl = coea2 - coeal

cc2 = coeb2 - coebl

cc3 = coec2 - coed

volb = 0#

yOl = (YT(numpoint) - YT(1)) / (XT(numpoint) - XT(1))

y02 = YT(1) - yOl * XT(1)

For gau = 1 To numpoint - 1

al = XT(gau)^

bl = XT(gau + 1)

si = YT(gau)

tl = YT(gau + 1)

Uses numerical integration to calculate the volume of rock.

Call gausb(al, bl, si, tl, yOl, y02, ccl, cc2, cc3)

volb = volb + gausb(al, bl, si, tl, yOl, y02, ccl, cc2, cc3)

Next gau

volb is the volume; ganmiab is the unit weight of the rock.

120 volb = volb * gammab

volb is now a weight.
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8.2 Water Force

C b'
d'

B

D

D
C

B

(a) (b) Vertical section
tbrough line AB.

Figure 8.1 Folded rock geometry modeled as a prism.

Three cases are considered:

a. Drained case,

b. Undrained case and

c. Partially Drained case.

8.2.1 Drained case

In the Drained case, we assume that the water level is equivalent to plane

Ab'c'(See Fig. 8.1). Using the same method used above, we can get the magnitude of the

total water force F" as following:
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1^1 = ̂Ab\'fBd X yx sin(a^/sin( - d) (8.1)

where is the volume of block Ab'c'f Bd', yis the unit weight of water.

The calculation of the volume of the block is complicated and requires the use of

the three point Gaussian Numerical Integration Method. For example, set the origin at

point E ( point E is in the vertical plane going through line AB), axis perpendicular to

line AB and downward, axis x horizontal and axis z parallel to line AB. Then we can get

the equations of plane Ab'c' and plane Bd'h'c'f:

plane Ab'c': Zj = AjX+B^y + Q

plane Bd'b'c'f: = Aye + +C2

Let i2denote the projection district of plane Bd'b'c'f at plane z = 0, then the

volume of block Ab'c' can be calculated as follows:

= //(^i-^2}^dy (x.yeQ (8.2)

We can easily convert the above equation into the following form:

D ir) (8J)

then we have

=  (8.4)
i=l i=l

Here ̂  and ijj are Gauss points, and and Hj are Gauss coefficients If three Gauss

points are applied, the three Gauss point are -0.774596692, 0, 0.774596692, the Gauss

coefficients corresponding to the Gauss points are 0.5555555559, 0.8888888889,

0.5555555559.

The direction of /^is perpendicular to plane Ab'c'.
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8.2.2 Undrained Case

In the Undrained case, the water plane is a'b'c'e'. It is a horizontal plane. The

method used to calculate the water force is the same as that used in wedge failure. One

difference is that the Gaussian Numerical Integration Method is adopted to calculate the

volume of block a'b'c'e'AB in prismatic failure. Total water force F^is

F'=r'-F' (8.5)

the meaning of F' 'and F' is the same as that in wedge failure.

8.2.3 Partially Drained Case

The calculation method is the same as that used in wedge failure. Total water force F

is

F=F+(F'-F) X W/100 (8.6)

8.2.4 Program Code

The code used in RockSlip to calculate the water force is listed below. Overall, the

code follows the algorithms outlined in the previous sections for calculating the water

force in each case. Some differences, exist in the variable names and the order in which

quantities are calculated. Also, the code contains the logical operators used to distinguish

between the different cases and in some instances, the different slope geometries that are

possible.

Determination of maximum water level pemiitted.

Dim zwmax, zwl, yin, xl2, yl2 As Single
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.  Dim sym As String

zwmax = (ylow - yinO) * Sin(gl) / Sin(ql - q2)

If zwmax = 0 Or zw = 0 Then GoTo 90

At the beginning, should input zw. Detemine whether data entry is wrong.

If zw > zwmax Or zwmax < 0 Then

sym = Str$(Int(zwmax))

If zwmax < 0 Then sym = "0"

Msg = "Maximum zw permitted is " + sym + vbCrLf

Msg = Msg + "Your input is out of range !"

MsgBox Msg, vbOKOnly + vbCritical

Me. Hide

fOutcrop.Show

With fOutcrop.txtUserlnput(5)

.SetFocus

.SelStart = 0

-SelLength = Len(.Text)

End With

Exit Sub

End If

Determination of the water plane level. Prepare for the calculation of water pressure,

zwl = zw * Sin(ql - q2) / Sin(ql) v

zwl = distance between AB & FC Fig 2b.
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yin = ylow - zwl

yin = distance between DE & FC Fig 2b

The following variable arrays are used to store the coordinates of the intersection points

of the water level with the true section.

Dim x22(2), y22{2) As Single

XTO & YTO are the coordinates of the endpoints of the line segments in the true profile.

For i = 1 To numinO - 1

If XTO(i) - ''xTO(i + 1) = 0 Then

xl2 = XTO(i) ^

yl2 = yin

Else

dd = slope of each plane in the true section.

dd = (YTO(i + 1) - YTOd)) / (XTO{i + 1) - XTO(i))

Solve linear equation for ee : y = dd*x + ee.

ee = YTOd) - dd * XTO (i)

If dd = 0 Then GoTo 25

xl2 = (yin - ee) / dd

yl2 = yin
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End If

Is (xl2, yl2), as calculated in the previous block, a real intersection point? If so, store the

coordinates of the intersection as (x22(j), y22(j)).

If j = 2 Then GoTo 20

The next if then statement checks to see if plane in the true section is vertical.

If XTO(i) - XTO(i + 1) = 0 Then

The next 2 if then statements check the position of point yI2.

If yl2 >= yTO(i) And yl2 < YTO(i + 1) Then

x22 (j) = xl2

y22(j) = yl2

reco{j) = i

j = 2

End If

If yl2 = YTO(i + 1) Then

'x22 (j) = xl2

y22 (j) = yl2

reco(j) ='i + 1

j = 2

End If

End If

The next 2 if then statements check the position of point xl 2.
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If xl2 <= XTO(i) And xl2 > XTO(i + 1) Then

If yl2 >= YTO(i) And yl2 < YTOd + 1) Then

x22 (j) = xl2

y22(j) = yl2

reco(j) = i

j = 2

End If

End If

If xl2 = XTO(i + 1) And yl2 = YTO(i + 1) Then

x22 (j) = xl2

y22(j) = yl2

reco(j) = i + 1

j = 2

End If

Goto 25 ' This goto statement restarts the loop

This block is identical to the previous block except it determines the second intersection

point.

20 If XTO(i) - XTO(i + 1) = 0 Then
(

If yl2 = YTO(i) Then

x22 (j) = xl2

y22 (j) = yl2

reco(j) = i

End If

If yl2 < YTO(i) And yl2 >= YTO(i + 1) Then

x22 (j) = xl2
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y22(j) = yl2

reco(j) = i + 1

End If

End If

If xl2 < XTO{i) And xl2 >= XTO(i + 1) Then

If yl2 < YTO(i) And yl2 >= YTO(i + 1) Then

x22 (j) = xl2

y22(j) = yl2

reco(j) = i + 1

End If

End If

If xl2 = XTO(i) And yl2 = YTO(i) Then

x22 (j) = xl2

y22(j) = yl2

reco(j) = i

End If

25 Next i

Calculate the total number of points along the iimer water section.

Dim numinw As Integer

DimXTl(250), YT1(250) As Single

Dim LWl, LW2 As Single

numinw = reco(2) - reco(l) + 1

Get coordinates of true inner water section.

For i = 2 To numinw - 1
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k = reco(l) + i - 1

XTl(i) = XTO(k)

YTl(i) = YTO(k)

Next i

XTl(1) = x22(1) .

XTl(numinw) = x22(2)

YTl(l) = yin

YTl(numinw) = yin

Determination of some parameters related to water level (see variables diagram 1 b).

LWl = zw * Cos(ql - q2) / Sin(ql)

LW2 = (hs - he) / Sin(q2) + LWl

Determine water pressure(unfirozen~related to 0 of outlet frozen level).

Dim gau As Integer

Dim volw, YO, al, bl, si, tl As Single

Dim coebl, coeb2, coed, coec2, coeb, coec As Single

Dim coeal, coea2 As Single

30 volw = 0

YO = YTl(l)

For gau = 1 To numinw - 1 ' gau is a counter

al, bl, sl, tl are given values of the coordinates,

al = XTl(gau) ^

bl = XTl(gau + 1)

sl = YTl(gau)
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-tl = YTl(gau + 1)

coebl = LW2 / (ylow - YTl(l))

coed = -coebl * YTl(l)

coeb2 = LWl / (ylow - YTl(l))

coec2 = -coeb2 * YTl(l)

coeb = coebl - coeb2

coec = coecl - coec2

Call gauss(al, bl, si, tl, YO, coeb, coec)

Uses mmierical integration to calculate the volume of water (area abc in fig 2a). First

calculate coordinates of intersections of wedge planes with water plane for summer case.

Four points are calculated for each sliding plane, x & y coordinates (XT! (i), YTl(i)) are

determined for each point. The z coordinate (unnamed) is calculated so the point lies in

the plane.

volw = volw + gauss(al, bl, si, tl, YO, coeb, coec)

Next gau

Dim deltal, LL, LW As Single 'see fig. 2

deltal = (zw / Tan(gl) + (hs - he) / Tan(g2))

deltal = (hs - he + zw) / deltal

^ deltal = Atn(deltal)

volw = volw * Sin(gl) / Sin(gl - g2) * gammaw

rn = -volw * Cos(deltal - g2)

rt = volw * Sin(deltal - g2)

Consider winter case. Outlet frozen level changes from 0-100%.
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r

LL = Sqr({XTl(l) - XTl(numinw)) ^ 2 + (YTl(l) - YTl(numinw)) ^ 2)

rn = rn - zw * wf * LL * si * gammaw / 2

Note: due to the assumption that the water pressure head is related to the length 2W in

both case a and c the assumption that follows is that there is a maximum drainage

impedance assumed, which is equal to the following: Max Drainage imped. = zw / (zw +

(hs - he)) x 100%.

8.3 Factor of Safety

The factor of safety is calculated as the ratio of resisting to driving forces. The

following code shows how cohesion is incorporated into the calculation of the resisting

forces. Several checks are performed on the resisting and driving forces to ensure their

validity.

8.3.1 Program Code

Calculates normal and driving forces.

rn = volb * Cos(q2) + rn'normal component of weight

rt = volb * sin(q2) + rt 'driving Component of weight

Checks to see if calculated driving force is valid.

If rt <= 0 Then

Msg = "Driving force is upward or 0 !" + vbCrLf
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Driving force points up along line of intersection (very safe).

Msg = Msg + "Safety Factor is set to 999999."

MsgBox Msg

FSIC = 999999

Exit Sub

End If

Checks to see if calculated normal force is valid.

If rn < 0 Then

Msg = "Normal force is negative"'(hO frictionivery unsafe)

MsgBox Msg

FSIC = 0

Exit Sub

End If

Dim cohesion As Single

Calculates cohesion force on all planes and sums the results,

cohesion = 0

For i = 1 To numplanes

cohesion = cohesion + si * LT(i) * cohe

This is the cohesion force.

Next i

m = normal force
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FSl is equal to FS in eq 24 (Mauldon & Ureta) (assumes zero cohesion). We multiply

FSl by (Rn/(Rt tan delta)) to obtain FS in eq 23 (M&U). Then add cohesion to the

resistance. FSIC incorporates cohesion.

FSIC = (rn * FSl / Tan(PI / 2 - q2) + cohesion) / rt

If FSIC < 0 Then

FSIC = 0

End If
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Part IX

Conclusions
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Conclusions

A family of three computer programs, entitled ROCKSLIP, has been developed to

rapidly assess the stability of a wide variety of rock slope configurations. The user-

fiiendly setup of each program allows the user to quickly analyze the particular slope

geometry at hand. Visual Basic 5.0 Professional Edition© has been used to develop the

programs. The use of this 32-bit developing environment has allowed a compact and eye-

pleasing design for all the programs. All the programs are Windows based applications

and compatible with Windows 95/98/NT.

Several features make these programs unique arid powerful tools in the workplace.

The auto-redraw function serves as a flexible and practical design tool, making it possible

for professionals in the rock engineering field to perform complex studies, such as

sensitivity analyses, and for students to better visualize the orientations of each physical

component of the slope. An effort to better model the effects of water pressure has

resulted in a parameter entitled "drainage impedance". This parameter allows the user to

adjust the drainage conditions at the toe of the slope. The effects of cohesion, water

pressure and fiiction angle are also accounted for. Rockbolt reinforcement can be added

to the analysis. Number, length, orientation, tensile and shear strength and minimum

embedment can all be adjusted depending on the type of rockbolt and the installation

procedure used. There are some limitations to the programs. For instance, WedgeSlip

does not allow for a tension crack to be present (this feature will be added in a later

version).
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The contents of this thesis have summarized the work done on this project and

describe the three computer programs that have been designed. The User's Guides

provide a simple introduction to each program and explain the basics involved in

operating and obtaining results from the programs. The TDOT Slopes History (Appendix

B) demonstrates the need for further planning and development of methods to help

prevent future slope failures throughout Tennessee (especially Eastern Tennessee). The

ROCKSLIP family of programs marks a significant stride in the progression of analysis

techniques for rock slopes.
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ROCKSLIP Workbook Introduction

Chapter 1. Introduction

1.1 Program Development History

The original impetus behind this project was to implement a new rock slope

stability analysis method to analyze slopes consisting of folded rock geometries. Since

the failure surface is essentially a series of m planes (w>2), limiting equilibrium analysis

yields an indeterminate answer for these slopes. A method based on potential energy was

developed for stability analysis in such cases. For a detailed explanation of this method,

please see Mauldon and Ureta (1996) and Mauldon, Arwood and Pionke (1998). This

analysis technique was adapted into a computer program entitled RockSlip. As time

progressed, additional programs to analyze other basic rock slope geometries were
y

developed. WedgeSlip and PlaneSlip were the results of this effort. The set of three

programs is referred to as the ROCKSLIP package. The current version of the programs is

version 1.3.

1.2 Program Features

•  Windows Based - All three programs are Windows based and are compatible with

Windows 95/98/NT operating systems.

•  Units of Measurement - All three programs allow for the use of two different

measuring systems, :Q)s (English) and SI (Metric). PlaneSlip and WedgeSlip

automatically convert between the two.

•  Auto-Redraw - Included in PlaneSlip and WedgeSlip. The auto-redraw function
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enables the user to change key parameters and see, in "real-time", how these

changes affect the slope's stability.

•  Rockbolts - The effects of rock reinforcement are included in PlaneSlip and

WedgeSlip. Parameters such as number, orientation, tensile and shear capacity,

minimum embedment length and horizontal spacing can be defined for the rock

reinforcement.

•  Examples - Included in PlaneSlip and WedgeSlip. Several example problems are

included under the pull-down menu "Data", which are based on published results.

•  Water Level - Included in PlaneSlip and RockSlip. The height of water in the

tension crack controls the magnitude of water pressure acting on the slope.

•  Drainage Impedance - Included in PlaneSlip and RockSlip. A parameter entitled

"drainage impedance" has been incorporated into the program, which allows the

user to change the pressure distribution behind the slope by varying the drainage

conditions along the sliding plane and at the toe of the slope.
1

•  Tension Crack Angle - Included in PlaneSlip. The angle of the tension crack can

also be adjusted. This is a feature that has not been included in much of the

previous work on rock slopes (e.g., Hoek & Bray, 1981).

•  Graphical Output - WedgeSlip displays a choice of several diagrams (including

upper and lower hemisphere stereographic projections, cross section and variables

diagram) which aid the user in grasping the physical scenario.

•  Water Pressure - Included in WedgeSlip. The effects of water pressure on wedge

stability are also accounted for with the average water pressure parameters.
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•  Y2K Compliant - PlaneSlip, WedgeSlip and RockSlip include no reference to

date and are therefore fully Y2K compliant.

1.3 Assumptions

The following assumptions are made in all three programs:

►  All forces are assumed to act through the centroid of the sliding mass. This

implies that there are no moments created by the forces acting on the block. The

error introduced by ignoring the moments is negligible (Hoek & Bray, 1981).

►  The shear strength of the sliding plane is defined by the Mohr-Coulomb criterion:

Tf =c+orf tancj) (1)

where Tf = shear stress at failure, c = cohesion, a\= effective normal stress at

failure, and (|) = friction angle.

►  In PlaneSlip and WedgeSlip, the block is treated as a rigid body. In RockSlip, the

block itself is assumed to be imdeformable, deformation occurring only at the

contact faces.

The block is acted upon by an active resultant force R, which includes self weight,

and may include other forces, such as water forces and rockbolt forces.

►  The frictional shear stresses are assumed to act parallel to the direction of sliding

only (Hoek and Bray, 1981; Chan and Einstein, 1981). This is a standard

assumption in limiting equilibrium analyses of slopes.
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1.4 Disclaimer

The authors disclaim any responsibility for the correctness of the data generated

by the PlaneSlip package, or for the consequences resulting from the use thereof. Any

use or misuse of this package is the sole responsibility of the user.

I
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Chapter 2. PlaneSlip Examples

2.1 Limiting Equilibrium

The term "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. Thus, one must define an index which

describes the relationship between driving and resisting forces for each geometric and

mechanical situation in a rock slope. This is traditionally done using an index called the

Factor of Safety, defined as the ratio of the total resisting force to the total driving force.

For plane sliding including water pressure and rock reinforcement, the equation for

calculating the FS is as follows (Hoek & Bray, 1981). See Table A.l for definition of

variables.

cA + (Wcos\j/r5 -U-Vsinvi/p +NhFb cosP)tan{t) + (NbS|3 /Sh)
FS ;—~ (2)

Wsinv|/p + Vcosvj/p -N^F^ smp

Table A.I. Defiuitiou of Variables {PlaneSlip)

Variable Descnpfiou

FS Factor of safety

c Cohesion

A Area of failure surface

W Weight of sliding mass

Dip of failiue plane

u Uplift water force on failure plane
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Variable Description

V Water force on tension crack

4) Friction angle

Nb Number of rockbolts with embedment length greater than the minimum.

Fb Tensile force in rockbolts

P The angle the bolts make with the normal to failure plane

Sb Shear strength of rockbolts

Sh Horizontal spacing of rockbolts

Additional Assumptions

The following assumptions are unique to PlaneSlip:

The sliding surface and the tension crack strike parallel to the slope surface.

Water enters the sliding surface along the base of the tension crack and seeps

along the sliding surface, escaping at atmospheric pressure where the sliding

surface daylights in the slope face. This is the case when there is no drainage

impedance at the toe of the slope. If drainage is impeded then the water pressure

distribution on the sliding surface is modified according to the amount of

impedance.

A slice of unit thickness is considered and it is assumed that release surfaces are

present, so that there is no resistance to sliding at the lateral boundaries of the

failure.

2.3 Worked Examples
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Example PS -1 Introduction to Features and Display Options

Source: Limestone Quarry in Alabama (xmpublished)

Orientation Data:

Slope Face Dip 54°
Top Face Dip 0°
Sliding Plane Dip 30°
Tension Crack Dip 90°
Slope Geometry:
Face Height 10 n
Upper Slope Length 2 m
Mechanical Parameters:

VpytrSleptLtacdi

';T«amik Osaiek And*

h DiroftrpptaSoip*

—jJ-

-ill"' Ly?

^jJ|30 " jJ"
.jJP likp* J
«^1" jJ»

Friction Angle 30°
Cohesion 0 kPa

Water Level 0 m

Unit Weight 27 kN/m^
Drainage Impedance 0 %
Output:
Factor of Safety 1
Max. Water Level 4.65 m

I DmatCt lB9«faae*

I LcacthofiedAolU 141 jJP 2J»
« jJP Ll°
re _<J^
SK jJP

hactor of Safety = I (ij
Maximum zw ~ 4.65 m

—jjk,

Figure PS - la

Discussion:

This introductory example introduces the user to some of the major plotting and
calculation options available in PlaneSlip. To access Example 1 go to Data => Examples
=► Example 1 (Limestone Quarry). When the example first appears the variables
diagram will be in the picture box. To be able to view the slope cross-section the user
must turn off the variables diagram. To do this go to Display =» Variables Diagram and
click. Note the pictiue controls in the lower left hand comer of the picture box. The cross-
section should be small and off-center when it first appears. Increase the size by clicking
on the "+" button and adjust its position with the horizontal and vertical scroll bars.

PlaneSlip handles the calculation of water pressure for stability calculations in a
different manner than in WedgeSlip. The parameter that controls water pressure in
PlaneSlip is the water level in the tension crack. Try raising the water level to 2 meters.
Notice the decrease in the factor of safety. Now imagine that the slope undergoes an
episode of freezing temperatures. The drainage may be impeded due to water which
cannot exit from the toe of the slope because it has frozen. PlaneSlip can accoimt for not
only this occurrence, but for any existing condition which may worsen drainage
conditions, with a parameter entitled drainage impedance. Try raising the drainage
impedance to 50%. The screen should look like Figure PS - lb and the factor of safety
should drop from 1 to 0.56.
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Figure PS - lb

Now examine the effects of rock reinforcement. To add rockbolts to the slope
simply adjust the number of rockbolts (located directly below the drainage impedance
input). Note the increase in the factor of safety. Try shortening the bolts. What happens to
the cross-section diagram when a rockbolt ceases to meet the minimum embedment
requirement? What happens to the factor of safety? Another important aspect of rock
reinforcement is the angle at which the rockbolts are installed. Notice how the factor of
safety responds to changes in the rockbolt angle. The bolt axial force represents the
total force transmitted to the sliding plane by the rockbolt. Depending on what is required
to generate the force in the bolt (i.e., is it motion in the slope or is the bolt post-
tensioned?), the force can be chosen from a list of typical rockbolt parameters. Simply go
to Data Typical Rockbolt Parameters and choose the value of axial force
accordingly. Horizontal spacing is another aspect of rockbolts that PlaneSlip accounts
for. If horizontal spacing increases the factor of safety should decrease and vice versa.
Finally, one may include some shear resistance or "dowel effect" for the rockbolts.
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Example PS - 2 Water Pressure and Rock Reinforcement

Source: TRB Special Report 247

Orientation Data:

Slope Face Dip 70°
Top Face Dip 11°
Sliding Plane Dip 30°
Tension Crack Dip 90°
Slope Geometry:
Face Height 30 m
Upper Slope Length 15 m
Mechanical Parameters:

Friction Angle 25 °
Cohesion 96 kPa

Water Level 9 m

Unit Weight 25 kN/m^
Drainage Impedance 0 %
Output:
Factor of Safety 1.13
Max.Water Level 18.06 m

UpperSkp*I«a(tH ^ '

jj°
DlpofDppwSloili i! aS ^ i * 1 " '
Dipefren ..

DwIkofloelMtt U JJb

of nctteb

Bolt Arul Toie* IB kN

Factor of Safety = 1.13(1.1286)

Maximum zw= 18.06 m

Figure PS - 2a

Discussion:

This example is designed to help the user better understand the rock reinforcement
and water pressure functions in PlaneSlip and also perform a small sensitivity analysis.
To access Example 2 go to Data =► Examples =» Example 2 (TRB Special Report 247,
1996). Turn off the variables diagram and adjust the size and position of the cross-section
as desired. Now your screen should be similar to the one pictured in Figure PS - 2a.

The calculated factor of safety should be 1.13 for the tension crack approximately
half-filled with water. This factor of safety would be considered xmsafe as regards the
long-term performance of the slope. Therefore, stabilization measures should be taken for
this slope.

It is useful at this point to perform sensitivity analyses which can help indicate
which stabilization method is optimal. For example, if the option of stabilization through
increasing slope drainage is of interest, one may want to examine the sensitivity of the
slope to changes in the water level in the tension crack. For a dry slope (water level equal
to 0 m), PlaneSlip yields a factor of safety of 1.33. For a fully saturated slope (water level
equal to 18 m), PlaneSlip yields a factor of safety of 0.83. Even if measures were taken to
promote full drainage of the slope at all times, the factor of safety would be 1.33, which is
marginal for design purposes. Thus, from this sensitivity analysis, one can determine that
other stabilization methods need to be investigated.
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Figure PS - 2b

Rock reinforcement through the use of rockbolts or anchors is the next
stabilization option that needs to be examined. Begin with the initial slope conditions
(tension crack half-filled with water). Add one rockbolt. Use 0 = -10° to correspond with
the angle of 50° (defined differently) in the TRB report. Note that this is not the optimal
orientation but rather a practical decision based on installation and grouting procedures.
Increase the length of the rockbolt to at least 18 meters to meet the minimum embedment
requirement. Change the horizontal spacing to 1 m (this is so the example results will
match with the TRB analysis, which analyzes the reinforcement per unit length of the
slope). Now increase the bolt axial force till the factor of safety rises above 1.5 (typical
required factor of safety for slope design). Based on the above information the bolt axial
force required for this scenario is approximately 1500 kN. To make direct changes in
input simply delete the current value, type in the new value and click on "Update
Screen". Note that this value is for one rockbolt spaced at a unit length of Im. Different
combinations of spacing and bolt force could be used to obtain the design factor of safety.
Using a typical post-tension value of 75 kips (333 kN), five bolts would be needed per 1
meter of slope length (Figme PS - 2b). One way to enter this value for bolt force is to
select it from the Data =» Typical Rockbolt Parameters =» Rockbolt Axial Force
(based on post-tension stress) submenu. Regardless of the combination used, one should
perform the same sensitivity analysis as before with the reinforced slope to verity that it
will be stable under extreme conditions. For a fully saturated slope with reinforcement,
the factor of safety is 1.08. This is an acceptable factor of safety for this extreme
condition.
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Example PS - 3 Pull-down Menus; Saving Bitmaps

Source: Rock Slope Engineering by Hoek & Bray, 1981

Orientation Data:

Slope Face Dip 60°
Top Face Dip 0°
Sliding Plane Dip 30°
Tension Crack Dip 90 °
Slope Geometry:
Face Height 100 ft
Upper Slope Length 29 ft
Mechanical Parameters:

Friction Angle 30°
Cohesion 1000 psf
Water Level 0 ft

Unit Weight 160 pcf
Drainage Impedance 0 %
Output:
Factor of Safety 1.35
Max. Water Level 49.92 ft

tJppctSkiff* ^

Tamodi Cnek. Ani^i'

1 r iintfc nfrtrlfritHf
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Factor ot Safety = 1.35 (1.3463)

Maximum zw - 49 92 ft

Figure PS - 3a

Discussion:

To access Example 3 go to Data =» Examples =» Example 3 (Hoek and Bray,
1981). Turn off the variables diagram and adjust the size and position of the cross-section
as desired. Now your screen should be similar to the one pictured in Figme PS - 3a.

This example will illustrate the use of preset values for fiiction angle and unit
weight available in PlaneSlip. To access the preset values for fiiction angle go to Data =»
Typical Ultimate Strengths, phi, degrees (c = 0). The values listed are taken from
Franklin and Dusseault (1989). Note that there are two sections within this submenu,
"Thick joint fillings" and "Rock joints". There are six presets under "Thick joint fillings"
and nine xmder "Rock joints". The first six values are for cases where the infilling
substance in the joint or sliding plane provides the primary fiictional resistance to sliding.
The last nine are cases where there is little or no filling and the discontinuity contact
surfaces provide the majority of the fiictional resistance. There is a range of values
provided in the submenu for each case. The median value is inserted in the "Friction
Angle" input box when the preset is clicked on. However, the range of values should
provide a firamework within which good engineering judgement can allow for adjustment
of the median value to provide a more accurate estimate of the fiiction angle fi-om case to

To access the preset values for unit weight go to Data =► Typical Unit Weights
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(kN/m^). The values listed are taken from Goodman (1989). Once again, these values are
not written in stone and can be adjusted based on available test data and engineering
judgement. They are listed as typical values for the particular rock types.

Another interesting feature in PlaneShp is the ability to save the cross-sectional
diagram as a bitmap. First, position the cross-section in the picture box as desired. This is
done using the "+" and buttons to zoom in and out and the horizontal and vertical
scroll bars to adjust left and right position (See Example PS -1). Then go to Display =»
Save As Bitmap.... A dialog box should appear asking for a location and filename to save
the bitmap under. Select a directory to save the bitmap in and assign it a filename. The
bitmap can then be accessed and inserted into any typical word processing software
(Wor^erfect©, Word©). The bitmap can also be manipulated (image effects, add text) in
any image processing software that will open bitmaps ̂ aint©, Corel® Photo House).
Figure PS - 3b is an example bitmap created using Ae slope configuration in Example 3
with the tension crack fully filled with water.

Another way to create images using PlaneSlip is to capture the active screen and
paste it into a document. Simply get the form you want to capture on the screen and make
sure it is the active form. Then press "Alt + Print Scm". Windows captures the active
form. Now go to either a word processing or image editing program and use the 'Taste"
command. The entire form should appear as an image. An example of this process is all
the introductory program screens shown at the beginning of each the PlaneSlip example
problems.

Figure PS - 3b
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Example PS - 4 Bedding Plane Slides; Passive Reinforcement

Source: Saieb Haddad, TDOT Region One

Orientation Data:

U8B$$5BnBGEin3

Slope Face 70°
Top Face 30°
Sliding Plane 30°
T ension Crack 70 °

Slope Geometry:
Face Height 20 ft
Upper Slope Length 60 ft
Mechanical Parameters:

Friction Angle 30°
Cohesion 0 psf
Water Level 0 ft

Unit Weight 170 pcf
Drainage Impedance 0%
Output:
Factor of Safety 1
Max. Water Level 20 ft

UxparSbi^* LcacOi
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-  ofwsUeltf IB ̂ (30 jjfl
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Factor of Safely =1 (1)

Maximum zw = 20 ft

Figure PS - 4a

Discussion:

To access Example 4 go to Data => Examples =» Example 4 (Uniformly Bedded
Rock). Turn off the variables diagram and adjust the size and position of the cross-
section as desired. Now your screen should be similar to the one pictured in Figure PS -
4a.

Reinforcement for bedding plane slides such as are common is East Tennessee is
usually placed through the top face rather than the slope face. Although the current
version of PlaneSlip allows bolts to be placed only through the slope face, the program
can still be used for the stability calculation.

The use of rockbolts as active reinforcement in a rock slope has already been
discussed (See Example PS - 2). Now examine the use of rockbolts as passive
reinforcement. There are cases, such as this configuration, where rockbolts can be used as
"dowels" to hold the rock block in place. Note that if rockbolts are installed for this
purpose (i.e. they are not post-tensioned) care must be taken when including them in
stability calculations. It is recommended that sixty percent of the ultimate strength be
used to estimate the shear resistance of the bolts. Also, this value should be entered in the
"Bolt Shear Force" input box and not the "Bolt Axial Force" input box. This mixup can
be avoided by using the preset values available under the pull-down menus at the top of
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the screen. Simply go to the Data =» Typical Rockbolt Parameters =» Rockbolt Axial
Force (based on 60% ultimate strength) submenu. Three preset values can be chosen
depending on the size of the bolt being used. When one of these values is selected
PlaneSlip automatically enters the correct value for the bolt shear force and zeroes out the
bolt axial force. It is not required that the preset values for shear force be used, but this is
a good method to insure that the value is entered in the appropriate input box and that the
axial force is reduced to zero. The latter insures that the rockbolt is truly being modeled
as a "dowel", providing only shear resistance to sliding.

Try adding rockbolts as "dowels" to this example. Use the 1" nominal diameter
all-thread bar preset (76.5 kips). Assuming a minimum embedment requirement of ten
feet and horizontal spacing of five feet, three rockbolts are required to raise the factor of
safety above 1.5. The rockbolts need to have a minimum length of 25 feet to meet the
minimum embedment requirement. The rockbolts are oriented normal to the sliding plane
(6 = a4 - a2 = 70°- 30°= 40°). This configuration will produce an output screen similar to
Figure PS - 4b. The factor of safety should equal 1.55, which is sufficient for the dry
slope conditions. If the water level were to rise and fill the tension crack halfway, another
bolt would be needed to raise the factor of safety above 1.5 (1.51 for this case). Thus, it is
advisable to add the fourth bolt to account for the possibility of a partially saturated slope.
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Example PS - 5 Drainage Impedance

Source: Joshua Cole

Orientation Data:

Slope Face Dip 75 °
Top Face Dip 30°
Sliding Plane Dip 30°
Tension Crack Dip 80 °
Slope Geometry:
Face Height 10 n
Upper Slope Length 15 n
Mechanical Parameters:

£ie Clflla: Oi«ikv,

Friction Angle
Cohesion

Water Level

Unit Weight
Drainage Impedance
Output:
Factor of Safety
Max. Water Level

45°

OkPa

4m

25 kN/m^
-50 %

1.52

9.41 m
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Factor of Safety = 1.52 (1.52132)

Maximum zw - 9.41 m

Figure PS - 5a

Discussion:

To access Example 5 go to Data =» Examples =► Example 5 (Free Draining
Slope). Turn off the variables diagram and adjust the size and position of the cross-
section as desired. Now your screen should be similar to the one pictured in Figure PS -
5a.

This example will focus on the parameter entitled "Drainage Impedance". This
parameter allows the user to model drainage conditions at the toe of the slope more
accurately. If drainage at the toe of the slope is obstructed, then a positive value of
drainage impedance is used to model the situation. For cases where drainage at the toe of
the slope is expedited, the drainage impedance value will be negative. The negative value
of drainage impedance simply moves the point at which the water pressure distribution on
the slide plane reaches atmospheric pressure. For example, the slide plane may be highly
eroded near the slope face and even back into the slope (Figure PS-5b). In this case the
water flowing along the slide plane does not meet atmospheric pressure at the toe but
farther back along tiie slide plane. In fact, the free flow of water is the most likely cause
of weathering and erosion along the slide plane.

Values of drainage impedance range from -90 % to 100 %. A value of 100 %
would indicate that drainage is completely impeded for the slope. This will result in an
increased water pressure distribution on the slide plane and a lower factor of safety. On
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the other hand, -90 % signifies that water reaches
atmospheric pressure at a point 90 % of the slide
plane length back into the slope. Thus the water
pressure distribution would be drastically reduced
and the factor of safety increased. Example 5
begins with a value of
-50 % for the drainage impedance. This means that
the water pressure distribution goes to zero (i.e.
reaches atmospheric pressure) at a point halfway
along the slide plane. The initial factor of safety is
1.52. If the drainage impedance is lowered even
more to -90%, the factor of safety should rise to
1.61. Raising the drainage impedance back to the
neutral value of 0 % gives a factor of safety of 1.41.

Figure PS - 5c shows three different water
pressure distributions. The first distribution is for
drainage impedance equal to +50%. The second
for drainage impedance equal to 0%. And the final
distribution is for a drainage impedance of -50%.
This figure illustrates how PlaneSlip handles water
pressure based on the drainage conditions of the
slope.

/
Figure PS - 5b. Assumed water
pressure distribution for open

fi-acture.

+50%

0%

-50%

Figure PS - 5c. Variation of water
pressure distribution with respect to
drainage impedance.
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Chapters. WedgeSlip Exmapims

3.1 Limiting Equilibrium

The term "limiting equilibrium" means that the forces tending to induce sliding

exactly balance the forces resisting sliding. The Factor of Safety is defined as the ratio of

the total resisting force to the total driving force. For wedge sliding including water

pressure and rock bolts, the factor of safety equation is as follows. See Table A.2 for

definition of variables.

^ [Nj +N'i +NbFbCosp]Tan(|) + NbSb +(ciAi +C2A2)
WSin\|/i -NbFbSinP

Table A.2. Defiuitiou of Variables {WedgeSlip)

Variable Descriptiou ;

N'„ N'2 Effective normal forces on planes 1 and 2; Nj' = N; - UjAj

({)„ (j)2 Friction angle of planes 1 and 2

c,, C2 Cohesive strengths of planes 1 and 2

A„ Aj Area of planes 1 and 2

W  Weight of the wedge

il/j Plunge of the line of intersection of planes 1 and 2

Uj, U2 Average water pressure on planes 1 and 2

Nb Number of rockbolts

Fb Tensile force in rockbolts

P  Angle rockbolts make with normal to the failure plane

Sb Shear strength of rockbolts
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3.2 Worked Examples

Example WS -1 Introduction to Features and Display Options

Source: Limestone Quarry in Alabama (unpublished)

Orientation Data:

Plane Dip

1  30

2  71

3  0

4  54

Slope Geometry:
Face Height 10 m
Mechanical Parameters:

Dip Direction
244 O oint)
343 (joint)
227 (top face)
227 (slope face)

Friction Angle
Cohesion

Water Pressure

Unit Weight
Output:
Factor of Safety
Sliding Mode ,

Discussion:

30°

OkPa

OkPa

27 kN/m^

1

Single Plane on
Plane 1

LH

/
\

\
+w

Figure WS-la

This example introduces the user
to some of the major plotting and
calculation options available in
WedgeSlip. To access Example 1 go to
Data =» Examples =» Example 1
(Limestone Quarry).

The first objective of this
example is to familiarize the user with
the orientation data. First, plot the dip
and normal vectors for each plane. To
do this go to Lower Window =>
Stereograph(LH). A submenu should
pop up with several plotting options.
Simply click on Plot Dip Vectors and
the dip vectors should, appear on the
stereographic projection. Use the same
process to plot the normal vectors. Each
dip and normal vector is labeled (e.g.

LH

hi
W

Vi3

/
\ h2

Figure WS-lb
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"dl" is the dip vector for plane 1) according to the plane it is associated with. Note the
picture controls in the lower left hand comer of each of the picture boxes. Try adjusting
the position and size of both the cross-section and stereographic projection.

The next objective is to illustrate the auto-redraw function and the sliding mode
feature. Start lowering the value for dip direction 2 to 322 (from 343). Note how the
stereographic projection and the slope cross-section change in real-time as the value is
lowered. Once you get to 322 the sliding mode should change from single plane sliding
on plane 1 to double plane sliding.

Another important feature is the Highlight Removable Wedge option. To
activate this option go to Lower Window =»^ Stereograph(LH). Chck on Highlight
Removable Wedge and the appropriate area on the stereograph should be shaded in
yellow. Now lower dip direction 1 to 226 (from 244). The removable wedge should
change. Removability of wedges is discussed in detail by Goodman and Shi (1985).

LH

+w +Wi

Figure WS-lc Figure WS - Id

Now examine the effects of water pressure. Click on the button labeled "No
Water Pressure". It should change to "Include Water Pressure" and several input features
directly below the button should be enabled. The program initially defaults to a calculated
value of water pressure on each plane. Begin by zeroing out each water pressure. Now
examine how the factor of safety changes when ul and u2 are adjusted. You should
notice that the factor of safety is more sensitive to changes in ul. Now raise ul to 50 kPa.
This changes the sliding mode to single plane on plane 2. Another important aspect of the
program can now be demonstrated. When WedgeSlip determines that the sliding mode is
single plane, it detects which parameters affect the stability analysis and which ones
don't. In this instance, 4>i has no effect while 4)2 has a great effect on the factor of safety.
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Example WS - 2 Water Pressure; Sensitivity Analysis

Source: 1-40 Wedge (Russell Glass, NCDOT)

Orientation Data:

Plane Dip Dip Direction
1  36

2  61

3  0

4  76

Slope Geometry:
Face Height 200 ft
Mechanical Parameters:

250 (joint)
161 Goint)
212 (top face)
212 (slope face)

Friction Angle
Cohesion

Water Pressme

Unit Weight
Output:
Factor of Safety
Sliding Mode

Discussion:

30°

Opsf
Opsf
160 pcf

0.95

Double Plane

LH

\  ./
n4

h2

173W-

Figure WS - 2a

This example is based on an actual wedge slide that occurred along Interstate 40
just inside the North Carolina border on July 1,1997. All lanes of Interstate 40 were
closed due to continued sliding on the slope. Close to 200,000 cubic yards of material,
identified as the Pigeon Siltstone, had to be excavated. Rockbolts, horizontal drains and a
Brugg Cable Net system were installed as remediation measures. The information for this
example was furnished by F. Russell Glass of the North Carolina Department of
Transportation.

To access the data for Example WS - 2 go to Data =»■ Examples => Example 2 (I-
40 Wedge). Plane 1 is identified as a bedding plane. Plane 2 is a through-going joint set.
Planes 3 and 4 are the top and slope faces, respectively. The orientation data with the dip
and normal vectors for each plane are plotted in Figure WS - 2a. The initial factor of
safety is less than one (0.95), indicating that the slope is unstable based on slope
geometry alone.

Water pressure was identified as the most likely contributor to slope instability in
this wedge slide. Heavy rains in the days that preceded the failure caused water pressures
to build up in the slope. Let's perform a small sensitivity analysis to demonstrate how
much the factor of safety is affected by changes in water pressure for this geometry. Click
on the "No Water Pressure" button. It will change to "Include Water Pressure" and
default values of water pressure (based on slope geometry) will be entered in the stability
calculations. The default value is 2080 psf for this slope geometry. With this water
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pressure acting on the wedge, the factor of safety drops to 0.60 (Figure WS - 2b). Now
zero out the water pressure on plane 2 and begin to adjust the water pressure on plane 1.
Examine the factor of safety at regular increments of water pressure (for example, 1000
psf). The following table presents the results of a sample sensitivity analysis for this
slope.

0 (Single Plane Sliding on Plane 2)

0 (Single Plane Sliding on Plane 2)

Table WS -1. Sample sensitivity analysis in WedgeSlip.

As illustrated by the above table, the slope is much more sensitive to changes in
the water pressure on plane 1. At 2000 psf, the effective normal force on plane 1 is
negated and the sliding occurs along plane 2 only. The results of this example show that
the slope in this case is highly susceptible to changes in water pressure, especially along
plane 1. Thus, WedgeSlip verifies that heavy rains and a build up of water pressure in the
slope were indeed the culprit of the 1-40 wedge slide.

fig UaisWMin; InncWMw Ojlg

I i9dfaKtigM3 cfl ®

lodilgtlg m < ||o > I

IWtrfggdtglu I» < ||30 > |»

ta^gfadtolU > 1°

BggitetnMUiai FB < ||?5 >

BofJiWBihiMfact ST > [t^ 4I

'  v. i

.  l7'.I>g&A n ■(

Uld|.Uai ^1

I  Double Plane Sliding
I  Fartor cif Safety » O.R (0 fiOOl)
Plunge d Ire d Iniesectasn ■ 34
Trend ol Lv* d Intaieclnn • 2^
DhedalAnc^ >113.85
Area of Plane! •6420S.97
Area of Plane 2 > 34185.43
yolune of Wedge >3760316
Waght>6.0174SSE*0e
Effectave Normal fleacbon. NV > 3.0716lSE*0e
EKediye Normal Reacbon. N2' • 4.361427E *07
BP 0011 s the lemovaUe block.
JP 00 it the removable jort pyrand

Figure WS - 2b
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Example WS - 3 Symmetric Wedge

Source: Dr. Matthew Mauldon

Orientation Data:

Plane Dip Din Direction
1  54.74 315 (joint)
2  54.74 45 (joint)
3  0 180 (top face)
4  90 0 (slope face)
3  0 180(topfa<
4  90 0 (slope fac
Slope Geometry:
Face Height 1 m
Mechanical Parameters:

Friction Angle
Cohesion

Water Pressure

Unit Weight
Output:
Factor of Safety
Shding Mode

30°

OkPa

OkPa

25 kN/m^

0.71

Double Plane
Figure WS - 3a

Discussion:

The following example is a case designed to utilize symmetry for ease of
calculation. The wedge that is to be analyzed can be visualized as a portion of a cube. For
this example, the sides of the cube are set at an arbitrary length of 2.

ProfUeView
DD2 ^ DDI

Top View

Figure WS - 3b. Wedge slide schematic.
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To access the data for Example WS - 3 go to Data => Examples => Example 3
(Symmetric Wedge). The orientation data for this example is shown in Figure WS - 3a.
Since the wedge is symmetric, the limiting equilibrium analysis is simplified. The table
below (Table WS - 2) presents the results of a verification exercise done using this
symmetric data. Try changing various quantities in WedgeSlip and verify that the results
match those given in the table.

_l|ableJWS_^_2j_2^^e5ftg^erificationExerc^
4/10/99

h Vol y Wt. V a Area <t> c N T S P u N' 1 Fr 1 Fd FS FS

^WS}
1 0.33 26 8.67 45.00 109.47 0.87 30 0 0 1 1 10 0 3.75 4.33 6.13 0.71 0.71

1 0.33 27 9.00 45.00 109.47 0.87 30 0 0 1 1 10 0 3.90 4.50 6.36 0.71 0.71

1 0.33 28 9.33 45.00 109.47 0.87 30 0 0 1 1 10 0 4.04 4.67 6.60 0.71 0.71

1 0.33 29 9.67 45.00 109.47 0.87 30 0 0 1 1 10 0 4.19 4.83 6.84 0.71 0.71

1 0.33 25 8.33 45.00 109.47 0.87 10 0 0 1 1 10 0 3.61 1.27 5.89 0.22 0.22

1 0.33 25 8.33 45.00 109.47 0.87 20 0 0 1 1 10 0 3.61 2.63 5.89 0.45 0.45

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 0 3.61 4.17 5.89 0.71 0.71

1 0.33 25 8.33 45.00 109.47 0.87 40 0 0 1 1 10 0 3.61 6.06 5.89 1.03 1.03

1 0.33 25 8.33 45.00 109.47 0.87 30 5 0 1 1 10 0 3.61 12.83 5.89 2.18 2.18

1 0.33 25 8.33 45.00 109.47 0.87 30 10 0 1 1 10 0 3.61 21.49 5.89 3.65 3.65

1 0.33 25 8.33 45.00 109.47 0.87 30 15 0 1 1 10 0 3.61 30.15 5.89 5.12 5.12

1 0.33 25 8.33 45.00 109.47 0.87 30 20 0 1 1 10 0 3.61 38.81 5.89 6.59 6.59

1 0.33 25 8.33 45.00 109.47 0.87 30 0 2 1 1 10 0 4.81 7.56 5.55 1.36 1.36

1 0.33 25 8.33 45.00 109.47 0.87 30 0 4 1 1 10 0 6.02 10.95 5.20 2.11 2.11

1 0.33 25 8.33 45.00 109.47 0.87 30 0 6 1 1 10 0 7.23 14.34 4.85 2.96 2.96

1 0.33 25 8.33 45.00 109.47 0.87 30 0 8 1 1 10 0 8.43 17.74 4.50 3.94 3.94

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 5 1 10 0 6.62 8.65 5.02 1.72 1.72

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 10 1 10 0 9.64 12.13 4.16 2.92 2.92

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 15 1 10 0 12.65 15.61 3.29 4.75 4.75

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 20 1 10 0 15.67 19.09 2.42 7.89 7.89

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 5 10 0 4.21 9.86 5.72 1.72 1.72

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 10 10 0 4.21 14.86 5.72 2.60 2.60

1 0.33 25 8.33 45;00 109.47 0.87 30 0 1 1 15 10 0 4.21 19.86 5.72 3.47 3.47

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 20 10 0 4.21 24.86 5.72 4.35 4.35

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 20 0 4.18 5.83 5.55 1.05 1.05

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 40 0 4.08 5.71 5.25 1.09 1.09

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 60 0 3.91 5.52 5.03 1.10 1.10

1 0.33 25 8.33 45.00 109.47 0.87 30 0 1 1 1 80 0 3.71 5.29 4.91 1.08 1.08

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 1 2.74 3.17 5.89 0.54 0.54

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 2 1.88 2.17 5.89 0.37 037

1 0.33 25 8.33 45.00 109.47 0.87 30 0 0 1 1 10 3 1.01 1.17 5.89 0.20 0.20

1 0.33 25 8.33 45.00 109.47 0.87 |30 0 0 1 1 10 4 0.14 0.17 5.89 0.03 0.03

h Vol y Wt. V a Areal ̂ c N T S p u N' Fr Fd FS FS

(WS)
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Example WS - 4 Comparison of WedgeSlip to Other Analysis Methods

Source: B.K. Low

Orientation Data:

Dip Direction
105 (joint)
235 Ooint)
185 (top face)
185 (slope face)

Plane Dip
1  45

2  70

3  12

4  65

Slope Geometry:
Face Height 30.55 m
Mechanical Parameters:

Friction Angle 1, (J)i 30°
Friction Angle 2, (j)2
Cohesion 1, Cj

20°

24kPa

Cohesion 2, Cj
Water Pressure

Unit Weight
Output:
Factor of Safety
Sliding Mode

48kPa

66.7 kPa

25 kN/m^

1.32

Double Plane

LH
_

+W-:

//

Figure WS - 4a

Discussion:

This example is taken from a paper by B.K. Low entitled "Reliabihty Analysis of
Rock Wedges". To access the data for this example go to Data => Examples =► Example
4 (B.K. Low, 1997). The orientation data for this example is shown in Figure WS - 4a.
Low uses this example to verify his closed-form equations by comparing them with the
Hoek and Bray vectorial method (Hoek and Bray, 1981). The factor of safety calculated
in WedgeSlip is 1.324. This result agrees with both Low's and Hoek and Bray's methods.

Now let's examine how WedgeSlip compares with both methods as far as sliding
mode and factor of safety is concemed. The subsequent data is used for all cases: h = 20
meters; y = 25 kN/m^; Yw = 10 kN/m^; (t)i = 30°; (})2 = 35°; c, = 25 kPa; C2 = 0 kPa; Slope
face = 65/045 (Dip/Dip Direction); Top face = 10/045. Note that Yw = 10 kN/m^ is used in
both Low's and Hoek and Bray's method. WedgeSlip uses a value of 9.81 kN/m^. This
may create a slight discrepancy between the methods, especially the ones where water
pressure plays a greater role.
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Table WS - 3. Comparison of WedgeSlip to other stability analysis methods.

Low's

Equation
Pi 6i Pi 6.

H&B

Vectorial

Dip
Direction 1

Dipt Dip
Direction 2

Dip 2 u

CASE 1

H&B

"f •- Til!

WedgeSlip

CASE 2

Plane 1

Plane 1

Plane 1

Plane 1

H&B 294 23 257 80 53.333 Plane 1 2.164

"  ,2.164 i

CASE 3 103 33 29 72 0.50 BiPlane 1.594

H&B 302 33 74 72 33.333 BiPlane 1.594

CASE 4 76 37

H&B 329 37

CASES

H&B

CASE 6

H&B

WedgeSlip n

.t,V20 ,

28

28

,".-28 --4, *

CASE 7 51 58 56 76

H&B 354 58 101 76

WedgeSlip .4.: 4354 -4 ""

CASE 8 30 88 57 78

33.333

.88

58.667

.72

48.000

W.6oo, .

0.52

34.667

34.667 •

.70

46.667

■46.667 ,

.74

49.333

■49333 -

BiPlane '

BiPlane

BiPlane

Plane 2

Plane 2

Plane 2 /L'

Plane 2

Plane 2

i Plane 2 < ■

Floats

Floats

1-594

.929

.0.929 1
:i«4: ■

F

No Wedge

No Wedge

No Wedge

H&B

\f4i
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Example WS - 5 Parameter Studies

Source: TRB Special Report 247

Orientation Data:
LH

WedgeSlip Examples

Plane Din Din Direction

1 45 265 (joint)
2 48 168 (joint)
3 10 196 (top face)
4 76 196 (slope face)
Slope Geometry:
Face Height 30 m
Mechanical Parameters:

Friction Angle 1, (t)] 35°
Friction Angle 2, (j)2
Cohesion 1, Cj
Cohesion 2, Cj
Water Pressure

Unit Weight
Output:
Factor of Safety
Sliding Mode

Discussion:

25°

20 kPa

lOkPa

OkPa

25 kN/m^

1.18

Double Plane

+w-

Figure WS - 5a

The following example is taken from the TRB Special Report 247 "Landslides:
Investigation and Mitigation". To access the data for this example go to Data =>
Examples =>■ Example 5 (TRB Special Report 247,1996). The orientation data for this
example is shown in Figure WS - 5a.

The initial factor of safety in WedgeSlip is 1.18. This value is slightly different
from the 1.23 calculated in the TRB report. The TRB report truncates intermediate
geometry and force values at the second decimal place, whereas WedgeSlip carries much
more precision in the values throughout the stability calculations. Nevertheless, both of
these values are not acceptable for most slope engineering design. Therefore, rock
reinforcement and other stabilization methods should be considered for this particular
geometry.

Another factor in the stability calculations are the parameters obtained through
laboratory testing. The TRB report suggests that if poor blasting practice had been
utilized in the excavation process, it is possible that the cohesion along the discontinuities
could have been destroyed. We can examine this scenario in WedgeSlip. Adjust the two
cohesive strength values to 0 kPa to model this situation. The factor of safety should drop
to 1.01 (Figure WS - 5b), which agrees with the TRB report. This illustrates the
importance of controlled blasting practice when creating permanent rock slopes.
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EQUAL ANGLE

LUR. HEHISPHERE

Figure WS - 5b

Another xincertainty is in the orientations of the discontinuities which make up the
wedge. The orientations are usually determined from analysis of preferably large,
imbiased data sets gathered in the field. This orientation data is then typically plotted as
poles on a stereographic projection (Figure WS - 5b) and analyzed to determine a
preferred or "best-fit" orientation for each major discontinuity. Contouring is a common
statistical method used to determine preferred orientation. Figure WS - 5c shows an
example of a contour plot.

FISHEK POLE
CONCENTRATIONS
X of total FOV>
t.Q y. ai»o>

LMR. HENXSPHERE

Figure WS - 5c
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Chapter 4. RockSlip Example

4.1 Potential Energy Minimization

RockSlip deals with failures involving multiple or curved sliding surfaces. The

analysis procedure, which was originally developed for stability analysis in folded rocks,

is based on minimization of potential energy. For a detailed explanation of the potential

energy minimization method please refer to Mauldon and Ureta (1996) and Mauldon et.

al. (1998). Due to the lengthy mathematical formulations involved, an explanation of the

method will not be presented here.

4.2 Additional Assumptions

The following additional assumptions are made in the potential energy model:

►  Each contact face of the rock block is assumed to have a normal stiffness of k„,

whereas the previously published work employed a uniform spring stiffiiess

constant for all contact surfaces.

►  An elastic, conservative system is assumed to determine the distribution of normal

forces that minimizes the potential energy of the system.

►  A local coordinate system is defined with the Z axis parallel to the fold axis and X

and Y in the plane orthogonal to the fold axis.

►  Each plane has a length X, in the XY plane, and since this is a prismatic block, the

other dimension of the contact plane will be taken as a unit length in the Z (fold

axis) direction.
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4.3 Worked Example

Example RS - 1 RockSlip Introduction

Source: Biltmore, TN

Orientation Data:

Fold Axis Trend 228 °
Fold Axis Plunge 11°
Outcrop Dip 75°
Outcrop Dip Dir. 225 °
Slope Geometry:
Upper Slope Length 10ft
Mechanical Parameters:

F riction Angle 20 °
Water Level 0 ft

Drainage Impedance 0 %
Cohesion 0 psf
Unit W eight 160 pcf

1  .8854167 II .1979167 | QfjcR on the photograph to define planes from right to left.
X-Coofdinale« Y-Co«diftMM ,

Nunbei ol poinU j 0 ]

Nunbet of planet I ^ 1
S.ave I Cioai ̂ « B.ack j

Figure RS - la

Discussion:

This example is taken from field data obtained from a site in Biltmore, Tennessee
as part of Scott Arwood's thesis work. The slope stability problems encountered on this
site were the initial impetus behind the development of the ROCKSLIP package of
programs.

The bitmap that is used in this example is entitled "Biltla.bmp". Click on File =>
Open Bitmap and go to the directory "C:\Program Files\Rs\Images" to find
"Biltla.bmp". Your screen should now look like Figure RS - la.

The next step is to define the failure planes. This is accomplished by pointing and
clicking the mouse to define each plane. Note that the planes must be defined from right
to left. RockSlip will yield a message saying that the factor of safety is infinitely high if
the planes are not defined correctly. Try plotting only two failure planes (traditional
wedge configuration) at first. Click on the "Next" button to move through the forms. The
outcrop data form should already have the example data entered by default. To calculate
the factor of safety (FS), click on "Next" on the outcrop data form and the results form
should appear. The factor of safety should be between 2.3 and 2.7 for the default data.
Note that the orientation of the two failure planes affects the calculated FS. Now try
using three planes to describe the failure surface. Click "Back" until the profile
photograph form is reached. Click "Clear All" and the previously defined failure surfaces
should disappear. Depending on how the three planes are selected the factor of safety
should be between 1.2 and 1.6 for the default data.
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Institute for Geotechnology. University of Tennessee. Knoxville ...HlaBRockSlip version 1.3

Calculate Stability

True Section
« Back Finish »

Number of points = 4
Number of planes = 3

Trend of fold axis =228

Hunge of fold axis =11
Outcrop Dip = 75
Outcrop Dip Direction = 225
Friction Angle =20

pparenl Section

The factor of safety is 1.608914

Figure RS - lb

Another important output on the results form is the apparent and true section
diagrams found on the left side of the form. These diagrams illustrate the difference
between the apparent section which is defined on the bitmap of the outcrop and the true
section which is being analyzed. This relationship is based on the trend of the fold axis
and the dip direction of the outcrop. Try lowering and raising either one of these values
while holding the other constant. You should notice a more pronounced difference
between the true and apparent sections. Also, the factor of safety should be affected. Do
these changes make sense with the data? Figure RS - lb shows the results form after
lowering the dip direction of the outcrop. Notice the difference between the true and
apparent section.
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Appendix B:

TDOT Region One Geotechnical Remediation Projects:

1973-1995

The purpose of the following group of charts is to present 22 years worth of

TDOT report data in a concise and easy to understand format. The data, compiled

represents active TDOT projects and their start dates (if available). Since some projects

spanned several years they show up several times in the yearly counts. Therefore, these

graphs should not be misinterpreted as a measure of new projects started each year, but

rather a quantification of the magnitude of remedial work TDOT had to perform each

year. Landslide projects are focused on in this brief report because they exhibit a striking

relationship to the rate of occurences through the years. Also certain counties seem to be

more prone to failures, as exhibited by the last set of charts. The t5q)es of geotechnical

projects are listed according to the determination made in the original TDOT Region One

Project Status Reports.

Note: L = Landslide, C = Cut slope, F = Fill Slope, S = Subsidence, SH = Sinkhole, and B = Backfill. 181
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Note: L = Landslide, C = Cut slope, F = Fill Slope, S = Subsidence, SH = Sinkhole, and B = Backfill. 182



2 o a p 0 C
u

V
i

N
'
*

C
u
p O

II *% p II w o
'

w C
/
)

& CO B
l
Q 3 O p X
/
1

j
r § w w p o g

N
u
m
b
e
r
 o
f
 L
a
n
d
s
l
i
d
e
 P
r
o
j
e
c
t
s
 S
t
a
r
t
e
d

o
 oi
 

o
 

en
 

B
 

N

I
 ̂ e

1

a
^
i
Z
l

m
m

1

N
u
m
b
e
r
 o
f
 P
r
o
j
e
c
t
s
 S
t
a
r
t
e
d

cn
 

o
 

cn
 

B
B

i8^ JS

k g •i
?

f fc I? S

^
^

I
S

I
^
S
S
l
S
l

-
-

s
 1

1
1 +

 1
I
S
s
I

1

-
-

m
m

-
-

-
-

-
-

m
s
m
m
m
m
m
m

-
-

-
-

-
- ^
g
m
s
m
m

m
m
&
\

1
 1

0
0



o !-
•

f
a
S a O o

li w o
"

>
T
3
n o
n

- 
a
*

C
A Bl ft 3 o _t
t

0
0

0
3 § C
u

w w ta o 5
^
C
i

N
u
m
b
e
r
 o
f
 A
c
t
i
v
e
 L
a
n
d
s
l
i
d
e
 P
r
o
j
e
c
t
s

fn
 

o
 

cj
i 

B
 

N
 

y

1
9
7
3

1
9
7
4

1
9
7
5

1
9
7
6

1
9
7
7

1
9
7
8

1
9
7
9

1
9
8
0

1
9
8
1

1
9
8
2

d
 
1
9
8
3

J.
 19

84
S
 1
98

5
1
9
8
6

1
9
8
7

1
9
8
8

1
9
8
9

1
9
9
0

1
9
9
1

1
9
9
2

1
9
9
3

1
9
9
4

1
9
9
5

T

1
9
7
3

1
9
7
4

1
9
7
5

1
9
7
6

1
9
7
7

1
9
7
8

1
9
7
9

1
9
8
0

1
9
8
1

1
9
8
2

d
 
1
9
8
3

J.
 19

84
S
 1
98

5
1
9
8
6

1
9
8
7

1
9
8
8

1
9
8
9

1
9
9
0

1
9
9
1

1
9
9
2

1
9
9
3

1
9
9
4

1
9
9
5

O
i

±
:

N
u
m
b
e
r
 o
f
 A
c
t
i
v
e
 P
r
o
j
e
c
t
s

g
 cs
 

y
 

N
 

y

c
.
c
3
0
f
^
\

.

:

El

0
0

-
1
^



N
u
m
b
e
r
 o
f
 A
c
t
i
v
e
 L
a
n
d
s
l
i
d
e
 P
r
o
j
e
c
t
s

o
 cn
 

N
O
I

2
3

A
n
d
e
r
s
o
n

B
l
o
u
n
t

Ca
mp

-C
la

ib
 ̂

C
a
m
p
b
e
l
l

C
a
r
t
e
r

C
l
a
l
b
o
r
n
e

C
o
c
k
e

C
u
m
b
e
r
l
a
n
d

Gr
ai
ng
er
 ̂

G
r
e
e
n
e

H
a
m
b
l
e
n

H
a
m
i
l
t
o
n

H
a
n
c
o
c
k

H
a
w
k
i
n
s

J
e
f
f
e
r
s
o
n

J
o
h
n
s
o
n

K
n
o
x

L
o
u
d
o
n

M
o
n
r
o
e

Mo
rg
an
 _
p

R
o
a
n
e

S
c
o
t
t

Se
qu

at
ch

ie
S
e
v
i
e
r

Su
ll
iv
an

U
n
i
c
o
i

Un
ic
oi
-C
ar
te
r

U
n
i
o
n

W
a
s
h
i
n
g
t
o
n

N
u
m
b
e
r
 o
f
 A
c
t
i
v
e
 P
r
o
j
e
c
t
s

in
 

o
 

en
 

K
 

W

A
n
d
e
r
s
o
n

B
l
o
u
n
t

Ca
mp

-C
la

ib
 ̂

Ca
mp
be
ll

C
a
r
t
e
r

C
l
a
l
b
o
r
n
e

C
o
c
k
e

C
u
m
b
e
r
l
a
n
d

Gr
ai
ng
er

G
r
e
e
n
e

H
a
m
b
l
e
n

H
a
m
i
l
t
o
n

H
a
n
c
o
c
k

H
a
w
k
i
n
s

J
e
f
f
e
r
s
o
n

J
o
h
n
s
o
n

K
n
o
x

L
o
u
d
o
n

M
o
n
r
o
e

Mo
rg

an
 ̂

R
o
a
n
e

S
c
o
t
t

Se
qu

at
ch

ie
 ̂

S
e
v
i
e
r

Su
ll
iv
an

U
n
i
c
o
i

Un
ic

oi
-C

ar
te

r

U
n
i
o
n

W
a
s
h
i
n
g
t
o
n

0
0



Vita

Joshua Cole grew up in Knoxville, Tennessee where he attended the public

schools of Knox County. He graduated from Bearden High School in May 1993. He

entered the University of Tennessee at Knoxville in August 1993 and received his

Bachelors degree in Civil Engineering in 1997. He then entered graduate school at the

University of Tennessee and served as a Graduate Research Assistant and Graduate

Teaching Assistant within the Institute for Geotechnology, a research group within the

Department of Civil and Environmental Engineering. He received his Masters degree in

August 1999.

186


	Computer assisted analysis of rock slope stability
	Recommended Citation

	Computer assisted analysis of rock slope stability

